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Introduction

About this Manual
This Programming Manual is designed to serve as an overall reference for programming the 
Panasonic Voice Processing System using KX-TVA Maintenance Console. It explains how to use KX-
TVA Maintenance Console, and obtain the most out of system administration.  
The Programming Manual is divided into the following sections:

Section 1, Programming Instructions
Describes how to install, start, and operate KX-TVA Maintenance Console.

Section 2, KX-TVA Maintenance Console Operating Instructions
Describes in detail each parameter that can be programmed using KX-TVA Maintenance Console.

Glossary
An alphabetical listing of features, terms, and abbreviations, as well as their definitions.

Index
An alphabetical listing of features and terms, as well as the page numbers of related sections.

About the Other Manuals
The following manuals are available:

Installation Manual
The Voice Processing System Installation Manual provides instructions for installing the VPS 
hardware, configuring the connected PBX for use with the VPS, and getting started with the KX-TVA 
Maintenance Console software. Relevant sections from the Installation Manual are listed throughout 
this manual for your reference.

Feature Manual
The Voice Processing System Feature Manual is an overall reference describing VPS features. It 
explains what the VPS can do, and how to obtain the most of its many features. Sections from the 
Feature Manual are listed throughout this manual for your reference.

Subscriber's Manual
The Voice Processing System Subscriber's Manual describes how subscribers can access 
commonly used VPS features and functions with their extensions and mailboxes. Relevant sections 
from the Subscriber's Manual are listed throughout this manual for your reference.

Note
• This manual may refer to products not available in your country/area.

• For KX-TD500, KX-TDA series PBXs, the term "trunk (CO line)" used in this manual indicates a 
trunk (CO line) group.

Trademarks
• Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation 

in the United States and/or other countries.
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• Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries 
in the United States and other countries.

• All other trademarks identified herein are the property of their respective owners.

• Screen shots reprinted with permission from Microsoft Corporation.
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Section 1

Programming Instructions

This section describes how to install, start, and operate KX-
TVA Maintenance Console.
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1.1 Introduction
1.1 Introduction

1.1.1 System Administration

VPS programming can be performed by the System Administrator, System Manager, and Message 
Manager. The type of programming performed by each is very different. While the System Manager 
and Message Manager can use their telephones to program the PBX, the System Administrator must 
use KX-TVA Maintenance Console and a PC.   
VPS programming performed by the System Administrator is referred to as "system administration". 

– System administration involves creating or changing VPS settings that control the manner 
in which VPS performs, and is usually done before any other programming. (The system 
manager can program some of these parameters with a telephone.)

– System administration can be performed by only one person at a time: a second person 
attempting to program the VPS will be denied access to system administration.

1.1.2 Password Security

To maintain system security, a password is required to perform system programming. When KX-TVA 
Maintenance Console is started for the first time, the Quick Setup needs to be set. Then, you will be 
asked to set the system password before the setup. To avoid unauthorized access and possible 
fraudulent dialing, do not disclose the password.

Warning to the Administrator regarding the system password

1. Please inform the customer of the importance of the password and the possible dangers if 
it becomes known to others.

2. To avoid unauthorized access and possible fraudulent dialing, maintain the secrecy of the 
password.

3. Please change the password periodically.

4. To prevent unauthorized access, we strongly recommend selecting a long and random 
password.

5. If the system password is forgotten, you have to reset the VPS to its factory defaults and 
reprogram it.
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1.2 Installing and Starting KX-TVA Maintenance Console
1.2 Installing and Starting KX-TVA Maintenance 
Console

1.2.1 Installing KX-TVA Maintenance Console

System programming, diagnosis, and data upload/download can be performed with a PC using the 
KX-TVA Maintenance Console software. 
This section briefly describes how to install and start KX-TVA Maintenance Console on a PC that is 
connected to the VPS via USB.

System Requirements
Required Operating System

• Microsoft  Windows  98 SE, Windows Me, Windows 2000, or Windows XP

Minimum Hardware Requirements

• CPU: 133 MHz Intel  Pentium  microprocessor

• HDD: 300 MB of available hard disk space

• RAM: 64 MB of free RAM (128 MB recommended)

Software Installation

Note

• To install or uninstall the software on a PC running Windows 2000 Professional or Windows 
XP Professional, you must be logged in as a user which is in either the "Administrators" or 
"Power Users" group.

• When the VPS is first connected to the PC via USB, a wizard should appear and ask you to 
select the appropriate USB driver. Browse for and select the KX-TVA USB driver, which is 
copied to the local drive during installation.

Updating other Panasonic Drivers

CAUTION
Installing the USB driver may prevent the USB driver for KX-TDA series or PC Console/Phone 
Software from functioning correctly. In this case, update the USB drivers as necessary from the 
following folders on the included CD-ROM: 
KX-TDA Series: CD-ROM Drive:\TDA_USB Driver\TDA_USB Driver 
PC Console/Phone Software: CD-ROM Drive:\TDA_USB Driver\T7601_USB Driver

Note

• Before installing or uninstalling the driver, be sure to close any open applications.

1. Copy the KX-TVA Maintenance Console setup file to a local drive on the PC. 
(Its icon is shown here, on the left.)

2. Double-click the setup file to run the installer.

3. Follow the on-screen instructions provided by the installation wizard.

4. Click Finish.

5. Click OK.

® ®

® ®
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1.2 Installing and Starting KX-TVA Maintenance Console
Windows 98SE

1. Connect the PC to the PBX with a USB cable.  
The Add New Hardware Wizard will appear.

2. Click Next.

3. Select Search for the best driver for your device. [Recommended], then click Next.

4. Select Specify a location, then click Browse.

5. Specify the folder containing the USB driver, CD-ROM Drive:\USB driver\Win98, then click OK.

6. Click Next.

7. Click Next.

8. Click Finish.

Note

• If a dialog box appears asking you to restart your PC, restart the PC.

Windows Me

1. Connect the PC to the PBX with a USB cable.  
The Add New Hardware Wizard will appear.

2. Select Specify the location of the driver [Advanced], then click Next.

3. Select Search for the best driver for your device. [Recommended].

4. Select Specify a location, then click Browse.

5. Specify the folder containing the USB driver, CD-ROM Drive:\USB driver\WinMe, then click OK.

6. Click Next.

7. Click Next.

8. Click Finish.

Note

• If a dialog box appears asking you to restart your PC, restart the PC.

Windows 2000

1. Connect the PC to the PBX with a USB cable.  
The Found New Hardware Wizard will appear.

2. Click Next.

3. Select Search for a suitable driver for my device. [Recommended], then click Next.

4. Select Specify a location, then click Next.

5. Click Browse, and specify the folder containing the USB driver, CD-ROM Drive:\USB 
driver\Win2000, then click Open.

6. Click OK.

7. Click Next.

8. Click Finish.

 
Windows XP

1. Connect the PC to the PBX with a USB cable.  
The Found New Hardware Wizard will appear.

2. Select Install from a list or specific location [Advanced], then click Next.
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1.2 Installing and Starting KX-TVA Maintenance Console
3. Select Search for the best driver in these locations.

4. Select Include this location in the search:, then click Browse.

5. Specify the folder containing the USB driver, CD-ROM Drive:\USB driver\WinXP, then click OK.

6. Click Next.

7. Click Continue Anyway.

8. Click Finish.
Programming Manual 11



1.2 Installing and Starting KX-TVA Maintenance Console
1.2.2 Starting KX-TVA Maintenance Console

Note

• The screenshots shown here are for reference only, and may differ from the screens 
displayed on your PC.

1. Click the KX-TVA Maintenance Console shortcut 
icon. Its icon is shown here, on the left.

2. Select the appropriate VPS model.

3. The Enter Programmer Code dialog box is 
displayed. Enter the programmer code (default: 
1234) and click OK.

Note

• The programmer code is required to use 
the KX-TVA Maintenance Console. The 
System Administrator can change the 
programmer code (see 1.8.9 Utility—
Programmer Code).

4. The Set Default Parameters window is displayed the 
first you start KX-TVA Maintenance Console. Select 
the TVA Type, PBX Type, and Integration Mode. 
Change the default parameters listed in the window 
if necessary, then click OK.
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1.2 Installing and Starting KX-TVA Maintenance Console
5. The main window is displayed.

6. Click Connect → USB from the menu bar, or click 
Connect on the shortcut bar, select USB in the 
Connection Mode dialog box and click Next.

Note

• To connect to the VPS via USB, the KX-
TVA USB driver must be installed on the 
PC, as explained above in "Installing KX-
TVA Maintenance Console".

7. Select the VPS as the desired USB device, enter the 
administrator password (default: 1234), then click 
Next.

Note

• The administrator password is required to 
access the VPS. The System 
Administrator can change the password 
(see Password in 2.8.1 Administrator).

8. Click Finish when the message Connected! is 
displayed.

9. You may now begin programming the VPS. To 
choose the area you would like to begin 
programming, click the desired icon in the Shortcuts 
menu.
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1.2 Installing and Starting KX-TVA Maintenance Console
Note

• If starting KX-TVA Maintenance Console for the first time, use the Quick Setup utility to set 
the administrator's password and other basic parameters (see 1.8.1 Utility—Quick Setup).

• Software features, design, and system requirements are subject to change.

Program Mode
When KX-TVA Maintenance Console is started, it enters Initial mode. From here, you can choose to 
enter Batch mode or Interactive mode to program the VPS.

a) Batch mode 
Batch mode allows you to create new system data files and make modifications to system data 
files saved on your PC without being connected to the VPS. Later, when you connect to the VPS, 
the system data stored in the PC can be uploaded to the VPS. 
To enter Batch mode, select an option from the File menu (see "1.3 File").

b) Interactive mode 
Interactive mode allows you to directly modify the system data and settings saved in the VPS's 
memory from a PC that is connected to the VPS. This mode displays the system data that is 
currently being used by the VPS. Data can be modified and results displayed in real time. To 
enter Interactive mode, select an option from the Connect menu (see "1.4 Connect").

Standard Buttons
There are several standard buttons that are displayed on many screens within KX-TVA Maintenance 
Console. 
The standard buttons are as follows:

Button Function

OK Accepts the settings that were made in the current screen and 
closes the screen.

Apply Accepts the settings that were made in the current screen and 
leaves the screen open.

Cancel Ignores any changes made in the current screen and returns to 
the previous screen.

Help Displays the relevant help topic for the current screen.
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1.3 File
1.3 File
The File menu allows you to create, open or save a data file. If "New" or "Open" are selected, KX-TVA 
Maintenance Console automatically enters Batch mode.

1.3.1 File—New

Creates a new system data file, and puts KX-TVA Maintenance Console in Batch mode. All settings 
are in their initial or default state. To upload the file created here to the VPS, see "1.8.2 Utility—
System Back Up".

Note

• Since selecting this option creates a new system data file, uploading this new file to the VPS 
as is will overwrite any settings that are saved in the VPS's memory. Use with care.

To create a new system data file
1. From the File menu, select New.

1.3.2 File—Open

Opens a system data file saved on the PC, and puts KX-TVA Maintenance Console in Batch mode.

Using the data without converting may result in certain data being loaded to an incorrect destination, 
and is not recommended.

System data files for unsupported VPS models cannot be opened. Only files saved with KX-TVA 
Maintenance Console can be opened. 
To upload the file modified here to the VPS, see "1.8.2 Utility—System Back Up".

To open a system data file
1. From the File menu, select Open.

The Open dialog box will be displayed.

2. Navigate to the folder containing the system data file you want to open.

3. Select the file.

4. Click Open.

a) Click Yes to convert the data for use with the current version of KX-TVA Maintenance 
Console. 
Enter a name for the new converted system data file.

b) Click No to open the file without converting it (not recommended).
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1.3 File
1.3.3 File—Close

Closes currently opened system data files, and enters "Initial mode". This menu is only available 
when using the KX-TVA Maintenance Console in "Batch mode".

To Enter Initial mode
• From the File menu, select Close. 

If the system data file being modified has not been saved, a warning message will be displayed, 
giving you the option to save the file.

a) Click Yes to save the file and close system data files to enter the Initial Mode.

b) Click No to discard the changes and close system data files to enter the Initial Mode.

1.3.4 File—Save

Overwrites the previously saved system data file with the system data currently being modified. 
To upload a file saved here to the VPS, see "1.8.2 Utility—System Back Up".

To save a system data file
• From the File menu, select Save.

If the data has never been saved, the Save dialog box will be displayed. For more details, see 
"1.3.5 File—Save As".

1.3.5 File—Save As

Saves the system data file being modified with the name chosen by the user. 
To upload a file saved here to the VPS, see "1.8.2 Utility—System Back Up".

To save a system data file with a new name
1. From the File menu, select Save As.

2. Navigate to the folder in which you want to save the file.

3. Enter a file name, or select a file to overwrite.

4. Click Save. 
If choosing to overwrite another file, a warning message will be displayed.

a) Click Yes to overwrite.

b) Click No to return to the previous screen.

1.3.6 File—Exit

Closes KX-TVA Maintenance Console.

To exit KX-TVA Maintenance Console
• From the File menu, select Exit. 

If the system data file being modified has not been saved, a warning message will be displayed, 
giving you the option to save the file.
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1.3 File
a) Click Yes to save the file and exit KX-TVA Maintenance Console.

b) Click No to discard the changes and exit KX-TVA Maintenance Console.
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1.4 Connect
1.4 Connect
The Connect menu allows you to directly program the VPS in Interactive mode. When connecting, 
you are required to enter the password corresponding to the administrator password entered when 
starting KX-TVA Maintenance Console.

1.4.1 Connect—USB

Connects to the VPS through the USB port on the VPS.

To connect using USB
1. From the Connect menu, select USB.

2. Enter the administrator password used to log on to KX-TVA Maintenance Console.

3. Click Next, and Finish when the connection is completed.

1.4.2 Connect—LAN (Optional for KX-TVA50)

Connects to the VPS through the LAN port of the VPS. 

Note

• Before you connect to the VPS via LAN, you must first assign an IP address to the VPS. See 
"1.8.11 Utility—LAN Settings" to assign an IP address.

To connect using a LAN
1. From the Connect menu, select LAN (TCP/IP).

2. Enter the administrator password used to log on to KX-TVA Maintenance Console and IP 
Address assigned to the VPS.

3. Click Next, and Finish when the connection is completed. 

1.4.3 Connect—Modem (optional)

Connects to the VPS through the modem.

Note

• To access the VPS remotely using this feature, a remote modem card must be installed. For 
more details, see "2.7.5 Modem Card (KX-TVA296)" in Installation Manual.

• To connect to the VPS using a PC with an external modem, you need to upgrade the KX-
TVA Maintenance Console software on the PC connected to the VPS.

The following settings must be entered to match the settings of the modem and/or PC.

Setting Values Description

Phone No. – Enter the phone number to dial into the VPS.

Port No. – Specify the number of ports.
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1.4 Connect
To connect using a modem
1. From the Connect menu, select Dial-up (Modem).

2. Enter the administrator password and the settings as required.

3. Click Next, and Finish when the connection is completed.

1.4.4 Connect—Disconnect

Closes the connection between KX-TVA Maintenance Console and the VPS.

To disconnect
1. From the Connect menu, select Disconnect.

2. Click Yes.

Password – Enter the password used to log on to KX-
TVA Maintenance Console.

Setting Values Description
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1.5 Edit
1.5 Edit
The Edit menu allows you to easily edit data in KX-TVA Maintenance Console.

1.5.1 Edit—Undo

Returns the last changed setting to its previous value.

To undo
• From the Edit menu, select Undo.

1.5.2 Edit—Cut

Cuts the selection and places it in the clipboard. 

To cut
• Select an area of text.

• From the Edit menu, select Cut.

1.5.3 Edit—Copy

Copies the selection and places it in the clipboard.

To copy
• Select an area of text.

• From the Edit menu, select Copy.

1.5.4 Edit—Paste

Inserts the contents of the clipboard.

To paste
• Place the cursor in the desired location.

• From the Edit menu, select Paste.

1.5.5 Edit—Select All

Selects the entire document.

To select all
• From the Edit menu, select Select All.
20 Programming Manual



1.5 Edit
1.5.6 Edit—Delete

Deletes selected items.

To delete
• Select an item to be highlighted.

• From the Edit menu, select Delete.
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1.6 View
1.6 View
The View menu allows you to hide/show the Tool Bar, Status Bar, Shortcut Bar, and Utility Bar.

1.6.1 View—Tool Bar

Selects whether the tool bar, which provides icons allowing easy access to commonly used functions, 
is displayed or not.

To hide/show the tool bar
• From the View menu, select or deselect Tool Bar.

1.6.2 View—Status Bar

Selects whether the status bar, which shows the connection status at the bottom of the windows, is 
displayed or not.

To hide/show the status bar
• From the View menu, select or deselect Status Bar.

1.6.3 View—Shortcut Bar

Selects whether the shortcut bar, which provides icons allowing easy access to each setting window, 
is displayed or not.

To hide/show the shortcut bar
• From the View menu, select or deselect Shortcut Bar.

1.6.4 View—Utility Bar

Selects whether the utility bar, which provides icons allowing easy access to each utility command, 
is displayed or not.

To hide/show the utility bar
• From the View menu, select or deselect Utility Bar.
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1.7 Go To
1.7 Go To
The Go to menu allows easy access to each setting window of KX-TVA Maintenance Console.

1.7.1 Go To—Mailbox Settings

Opens the Mailbox Settings screen.

To go to
• From the Go To menu, select Mailbox Settings and a sub-section.

1.7.2 Go To—Class Of Service

Opens the Class Of Service screen.

To go to
• From the Go To menu, select Class Of Service and a sub-section.

1.7.3 Go To—PORT/TRUNK Service

Opens the PORT/TRUNK Service screen.

To go to
• From the Go To menu, select PORT/TRUNK Service.

1.7.4 Go To—Service Settings

Opens the Service Settings Service screen.

To go to
• From the Go To menu, select Service Settings and a sub-section.

1.7.5 Go To—System Parameters

Opens the System Parameters screen.

To go to
• From the Go To menu, select System Parameters and a sub-section.
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1.7 Go To
1.7.6 Go To—H/W Settings

Opens the H/W Settings screen.

To go to
• From the Go To menu, select H/W Settings.

1.7.7 Go To—Reports

Opens the Reports screen.

To go to
• From the Go To menu, select Reports and a sub-section.

1.7.8 Go To—System Security

Opens the System Security screen.

To go to
• From the Go To menu, select System Security.
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1.8 Utility
1.8 Utility
The Utility menu provides access to the following functions and utilities:

– Quick Setup

– System Back Up

– System Prompts Customization

– Port Status

– System Trace

– System Maintenance

– System Initialize/Restart

– Diagnostic

– Programmer Code

– Software Version

– LAN Settings

– Default Parameters

To select an item from the Utility menu, click Utility in the menu bar, then select the desired function 
or utility.  
Certain Utility menu items are also available from the Tool Bar (System Back Up, Port Status, System 
Trace, and System Initialize/Restart).

1.8.1 Utility—Quick Setup

The Quick Setup utility allows you to set essential VPS parameters quickly and easily. It is particularly 
useful when connecting to the VPS for the first time or after initializing the VPS. The following settings 
can be programmed with the Quick Setup utility:

– System Security

– PBX Environment

– Mailbox Edit

– Port/Trunk Setting

– Time Setting

Note

• Set the desired parameters in each screen then click Next or Back to go to the desired 
screen.

• The Auto Configuration utility is available from the PBX Environment screen. This utility 
allows you to automatically create mailboxes for several extensions at once. When you click 
Next on the PBX Environment screen, Auto Configuration dialog box appears. Click OK 
to start Auto configuration, or Cancel to skip Auto Configuration and go to the next setting 
screen. Auto Configuration is available only in Interactive Mode and with Panasonic KX-T 
series PBXs using APT/DPT integration.

• In the Quick Setup-Finish window, you can change system date and time. You can click 
Finish to save the parameters, and "Quick Setup Completed" dialog box appears. Click YES 
to save the settings, or NO if you want to modify some settings.
Programming Manual 25



1.8 Utility
1.8.2 Utility—System Back Up

The following system programming data, system parameters, and voice data can be backed up or 
restored as individual files. 
The Backup History utility can be used to view a record of previous backups.

a) Program

– System Program

– DSP Program

b) System Parameters

c) System Prompts

– Installed Prompt

– Custom Service Menu

– Company Name

– Company Greeting

– System Mailbox Group Voice Label

– System Caller Name

– Prompt Selection

– Hold Announce Menu

– Extension Group Voice Label

d) Mailbox Prompts

– Owner Name

– Personal Greetings

– Personal Caller ID Name

– Interview

– Personal Group List Name

– EMD List Member Name

e) Mailbox Messages

Follow the steps below to use the System Back Up utility:

[Creation of Backup]

1. Click Utility in the menu bar.

2. Select System Back Up and Make Backup…. 
(You can click the icon in the tool bar instead of step 1 and 2.)

3. Check the desired item(s) to backup.

4. Click "Folder" icon.  
The Save dialog box appears. 

5. Navigate to the folder where to wish to save the system backup file.

6. Click Click to edit... next to Mailbox Prompts.

7. Check either All Mailboxes or select the mailboxes you wish to backup.

8. Click OK.

9. Click Click to edit... next to Mailbox Messages.

10. Check either All Mailboxes or select the mailboxes you wish to backup.

11. Click OK.
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Note

• The system will prepare the data to be backed up, and the backup will begin about 30 
seconds later. The time needed to backup the data will vary depending on the connection 
method, communication speed, and the amount of data that is being backed up.

• Deleted messages will not be backed up by the backup of the Mailbox Messages.

[Restoration of Backup Data]

1. Click Utility in the menu bar.

2. Select System Back Up and Restore the backup data. 
(You can click the icon in the tool bar instead of step 1 and 2.)

3. Check the desired item to restore.

4. Click "Folder" icon. 
The Open dialog box appears.

5. Navigate to the folder containing the desired backup file and select the file.

6. Click Open, then click Restore.

Note

• For KX-TVA50: The built-in flash memory must have space available to accommodate the 
restored data. If the backed up data is larger than the space available in the flash memory, 
the data cannot be restored.

[Backup History]

1. Click Utility in the menu bar.

2. Select System Back Up and Backup History. 
(You can click the icon in the tool bar instead of step 1 and 2.)

The following status of backup history can be checked in the Backup History dialog box:

– Description

– Parameters

– Completion Status (Completed/No Data/Error)

– Date & Time

– Total Elapsed Time (MM:SS)

3. Click Close.

1.8.3 Utility—System Prompts Customization

The System Prompts Customization screen is used to view, play, add, or delete system prompts. The 
System Administrator can also check the prompt number and text for these prompts. The following 
categories of system prompts can be customized from the System Prompts Customization screen:

a) System Guidance

b) Custom Service Menus

c) Company Greetings

d) Others

– Company Name

– Language Select Menu

– Hold Announce Menu

– Mailbox Group List Label

– Extension Group List Label
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– System Caller ID Name

Follow the steps to customize System Prompts:

1. Click Utility in the menu bar.

2. Select System Prompts Customization.

3. Select a tab in the System Prompts Customization dialog box.

[Deletion]

The System Administrator is able to delete the specific System Prompt or the installed language used 
for System Prompts.

To delete the specific system prompt:

1. Select the desired prompt number.

2. Click Delete.

3. Click OK.

To delete the installed language for system prompt:

1. Select the desired language, Guidance No.

2. Click Delete.

3. Click OK.

[Record of System Prompt]

1. Select the desired System Prompt to record, and click Play/Record.

2. Select "Record from extension" or "Import from recorded file".

When "Record from extension" is selected

1. Specify the extension number of the telephone used for recording, then click Connect.

2. When the specified extension rings, go off-hook.

3. Click  (record),  (stop), or  (play) to record or play a 
system prompt.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click …. 
The Open dialog box appears.

2. Navigate to the folder containing the WAV files you wish to import. (WAV files must meet the 
following specifications: IMA ADPCM codec, 8.000 kHz, 4-bit, mono.)

3. Select the desired WAV file.

4. Click Open to import the file.

5. Click OK.

[Start/Stop Playback of System Prompt]

1. Select the desired system prompts.

2. Click Play/Record.

3. Click Play or Stop.
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1.8.4 Utility—Port Status

The System Administrator can confirm the condition of each port and turn on/off VPS Call 
Progression Mode.

Follow the steps below to use the Port Status utility:

1. Click Utility in the menu bar.

2. Select Port Status.

(You can click the icon in the tool bar instead of step 1 and 2.)

The Port Status screen includes the Port Activity List which displays each port's status and 
number, as well as the current setting of Port Parameters. The screen will be updated every 2 
seconds. Each port's status will be displayed as follows:

– "Ready": The port is ready to be used.

– "Incoming Call": The port is handling an incoming call.

– "Outgoing Call": processing sending service

– "DSP Reset": processing DSP reset disposition

– "PT Connect": processing PT connect disposition

– "Offline": Off Line Mode

– "No Card": Available card is not installed.

[Turning on VPS Call Progression Mode]

1. Select the desired port and click Open Port.

2. Select Selected Ports to turn on the selected port, or select All Ports to turn on the all ports.

[Turning off VPS Call Progression Mode]

1. Select the desired port and click Close Port.

2. Select Selected Ports to turn off the selected port, or select All Ports to turn off the all ports.

3. Click Close.

1.8.5 Utility—System Trace

The System Administrator can monitor VPS activities and log the activities into a separate file. The 
following data can be logged for each port or all ports:

– DTMF/Dial: DTMF signals sent and received by the VPS.

– Guidance: guidance data that the VPS played.

– Message: the VPS activity on messages such as creating, playing and deleting.

– Process Event: events occurred between the VPS processes such as Application, Call 
Processor and DSP.

– Caller ID: Caller ID received from the PBX.

– Error: system errors.

– DID: DID number received from the connected PBX.

– PIN: PIN received by the VPS.

There are 2 methods for System Trace.

a) Real Time Trace: monitors the trace data of the selected port. Also, it is possible to log the 
monitoring data as a file.
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b) Internal Trace: logs the trace data of the selected port automatically in the system.

Follow the steps below to monitor or log the system trace data.

1. Click Utility in the menu bar.

2. Select System Trace. 
(You can click the icon in the tool bar instead of step 1 and 2.)

Real Time Trace

1. Select Real Time Trace.

2. Check Enable/Disable Trace Data.

3. Check the data and port you wish to monitor.

4. Click …, navigate the folder to save the monitored data as a file.

5. Click Apply.

Note

• During the "Real Time Trace", following features cannot be used:

– Other features in the Utility menu

– Recording features on a PC connected to the VPS (for Mailbox Group, Extension 
Group, System Caller Name, and Custom Service)

Internal Trace

1. Select Internal Trace.

2. Select Setting, Display, or Trace Clear.

– Setting: Disables or enables the Internal Trace feature, and specifies the data and port 
you wish to log.

– Display: Displays the trace data.

– Trace Clear: Clears saved trace data.

1.8.6 Utility—System Maintenance

The System Administrator can maintain the VPS using System Maintenance.

Follow the steps below for System Maintenance:

1. Click Utility in the menu bar.

2. Select System Maintenance.

3. Edit parameters in the System Maintenance dialog box.

4. Click OK.

System Maintenance Mode
Specifies whether to enable or disable System Maintenance Mode.

Default
Enable

Value Range
Disable, Enable
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System Maintenance Start Time
Specifies the System Maintenance start time.

Default
01:00

Value Range
HH:MM (HH: Hour, MM: Minute)

HDD Auto Stand-by Mode
Specifies whether to enable or disable HDD Auto Stand-by Mode.

Default
Enable

Value Range
Disable, Enable

HDD Auto Stand-by Delay Time
Specifies the length of time that the VPS waits before activating HDD Auto Stand-by Mode. If the time 
period expires without the access to HDD, the VPS will function HDD Auto Stand-by Mode.

Default
15 min

Value Range
0 min–21 min, 30 min/60 min

1.8.7 Utility—System Initialize/Restart

The System Initialize/Restart is used to restart the VPS. There are 2 methods as follows:

a) Initialize System: clears all voice data except the installed system guidance, and returns all 
system parameters to their default settings. The System Administrator has to specify the 
following parameters before initializing the system:

– Mailbox No. Length

– System Manager's Mailbox No.

– Message Manager's Mailbox No.

b) Restart System: restarts the system. The VPS is not initialized. 

Follow the steps below to initialize or restart the VPS:

1. Click Utility in the menu bar.

2. Select System Initialize/Restart.

Initialize System
Programming Manual 31



1.8 Utility
1. Select "Initialize System". 
(You can click the icon in the tool bar instead of step 1 and 2.)

2. Specify "Mailbox No. Length (2–5 digits)", "System Manager's Mailbox No." and "Message 
Manager's Mailbox No."

3. Click Next.

4. If there are active ports, the System Administrator will be asked to either to continue or to 
cancel. 
Select OK to continue, or Cancel to close the ports.

5. Click OK.

Restart System

1. Select "Restart System". 
(You can click the icon in the tool bar instead of step 1 and 2.)

2. If there are active ports, the System Administrator will be asked to either to continue or to 
cancel. 
Select OK to continue, or Cancel to close the ports.

3. Click OK.

1.8.8 Utility—Diagnostic

Diagnostic is used to diagnose the following hardware of VPS.

– Codec/DSP Voice Path: diagnoses whether the voice path between Codec and DSP 
functions properly.

– Play/Record Voice Path: diagnoses whether the voice path in the playing/recording unit 
functions properly.

Follow the steps below for System Diagnostic:

1. Click Utility in the menu bar.

2. Select Diagnostic.

3. If there are active ports, the System Administrator will be asked to either to continue or to cancel. 
Select OK to continue, or Cancel to close the ports.

4. Select Codec/DSP Voice Path or Play/Record Voice Path.

5. Diagnosis starts.

1.8.9 Utility—Programmer Code

The System Administrator can change the programmer code that is needed to use KX-TVA 
Maintenance Console.

Follow the steps below to change the programmer code:

1. Click Utility in the menu bar.

2. Select Programmer Code.

3. If the programmer code is already set, enter the old programmer code in Enter old programmer 
code:. 

4. Enter a new programmer code in Enter new programmer code:.
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5. Enter the new programmer code in Confirm new programmer code:.

6. Click OK.

1.8.10 Utility—Software Version

Software Version is used to display the version of main software and DSP software for reference.

Follow the steps below to display the software version:

1. Click Utility in the menu bar.

2. Select Software Version.

3. Click OK.

1.8.11 Utility—LAN Settings

The System Administrator can set the IP address and Port Number for the VPS. To program the VPS 
over LAN connection or to use E-mail Integration features, the VPS must first be connected to the 
LAN and programmed accordingly.

Follow the steps below for LAN Settings:

1. Click Utility in the menu bar.

2. Select LAN Settings.

3. Edit parameters in the LAN Settings dialog box.

4. Click OK.

Note

• The port number setting can usually be left unchanged.

• Consult the LAN administrator for the appropriate settings.

• The VPS must be restarted after these settings are changed in order for them to take effect.

IP Address
Specifies the IP Address for VPS.

Default
192.168.1.11

Subnet Mask
Specifies the Subnet Mask for IP Address.

Default
255.255.255.0
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Default Gateway
Specifies the IP Address for Default Gateway.

Default
192.168.1.1

Port No.
Specifies the Port No. for VPS.

Default
10000

Value Range
1–65535

1.8.12 Utility—Default Parameters

Specifies TVA Type, Mailbox No. Length, System Manager's Mailbox No., Message Manager's 
Mailbox No., PBX Type, Integration Mode, and some parameters as the default settings.

Follow the steps below for Default Parameters:

1. Click Utility in the menu bar.

2. Select Default Parameters.

Set Default

1. Select "Set Default".

2. Specify TVA Type, PBX Type, Integration Mode, and set parameters.

3. Click OK.

Load Default: Loads the parameters programmed in "Set default" to the VPS.

1. Select "Load Default".
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Section 2

KX-TVA Maintenance Console Operating 
Instructions

This section describes how to program the VPS using the KX-
TVA Maintenance Console software.
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2.1 Mailbox Settings
A maximum of 62 (KX-TVA50) or 1022 (KX-TVA200) subscriber mailboxes can be created. Although 
the System Manager can use a telephone to create or edit mailboxes, the System Administrator can 
create several mailboxes at once using KX-TVA Maintenance Console.

Mailbox parameters are divided into the following categories:

– Mailbox Parameters

– Notification Parameters

– External Message Delivery settings

– Auto Forwarding settings

– Personal Distribution Lists

– Personal Custom Services

– Remote Call FWD to CO settings

– Automatic Log-in settings

– E-mail Option

Click each tab at the bottom of Mailbox Settings screen to specify the desired parameters.
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2.1.1 Mailbox Settings Screen

This screen allows the System Administrator to visually browse and edit all mailboxes in the VPS. 
There are 2 types of screen: Edit Mailbox and the list of mailboxes.

Edit Mailbox Screen
When you click Mailbox Settings, Edit Mailbox Screen (mailbox setting window for the existing 
mailbox with the lowest number, or Mailbox 998 when there's no mailbox) is opened. From this 
screen, you can edit mailbox settings.

When you click Manage All Mailboxes In The System, or click OK in the "Mailbox" dialog box, the 
list of all mailboxes is displayed.

[Editing a Mailbox]

Editing the currently opened mailbox setting

1. Edit each Parameter in the Mailbox dialog box. 
(Click Save as Default Mailbox to use edited mailbox as the default mailbox settings 
for subsequently created mailboxes.)

2. Click OK.

To open the desired mailbox to edit

1. Click Manage All Mailboxes In The System, or click OK in the "Mailbox" dialog box.

2. Select the desired mailbox, then click Edit Mailbox....
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List of all mailboxes

This screen provides a list of all mailboxes. From this screen you can add new mailboxes, edit 
mailboxes, delete existing mailboxes, and copy mailbox settings to other mailboxes. Mailboxes can 
be sorted in ascending or descending order by parameter (mailbox number, first name, last name, 
etc.) by clicking the parameter name. 
When you click Add Mailbox... or Edit Mailbox, Edit Mailbox screen is displayed.

[Adding a Mailbox]

1. Click Add Mailbox....

2. Edit Parameters in the Mailbox dialog box. 
(Click Save As Default Mailbox to use added mailbox as the default mailbox settings for 
subsequently created mailboxes.)

3. Click OK.

[Editing a Mailbox]

1. Select the desired mailbox, then click Edit Mailbox..., or you can also double-click the cell 
on the screen to edit the specified parameter.

2. Edit each parameter.

[Deleting a Mailbox]

1. Select a mailbox you want to delete.

2. Click Delete Mailbox.

3. Click Yes.

[Copying a Mailbox Setting to other mailboxes]

1. Click the desired mailbox to copy, and press Copy Mailbox....

2. Copy Mailbox dialog box is displayed. Check the items to copy, and select the destination 
mailbox number. (Ctrl/Shift Key is available to choose several mailbox numbers.)
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3. Click Copy.
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2.1.2 Default Mailbox Template

The default mailbox template is applied to new mailboxes when they are created with the Add 
Range... button. This allows you to create similar mailboxes easily, with one command.

Follow the steps below to edit the default mailbox:

1. Click Add Range….

2. Specify a range of mailbox (From:/To:). 
(Check "Use the same number for Mailbox and Extension" as your needs.)

3. Enter the number of mailboxes to create in the "Number of Mailboxes".

4. Click Edit Default Mailbox….

5. Edit parameters in the Default Mailbox dialog box.

6. Click OK to return to the Add Range Of Mailboxes dialog box.
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7. Click OK.

Feature Manual References
2.4.3 Default Mailbox Template
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2.1.3 Mailbox Parameters

Each mailbox can be edited based upon the needs of the subscriber.

Mailbox Number
Specifies the subscriber's mailbox number. Mailbox number length is set by using the Set Default 
Parameters utility or when Initialize System is selected. Mailbox numbers cannot begin with "0". If the 
length of the mailbox number has been defined as 4 digits, for example, the valid range for all mailbox 
numbers would be 1000 through 9997 (9998 and 9999 would be reserved for the Message Manager 
and the System Manager). The length of the mailbox number cannot be changed through the 
Mailbox Setting screen once it has been specified.

Note

• Mailbox number is only set when adding mailbox: when editing mailbox, you cannot change 
the assigned mailbox number.

Default
None

Value Range
2–5 digits
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Feature Manual References
2.3.16 Mailbox

Extension
Specifies the extension number of the mailbox's subscriber. 
Any valid extension number including an Extension Group List number can be assigned.

Note

• If an Extension Group List number is assigned to a mailbox, all group members are able to 
share the information stored in the mailbox.

Default
None

Value Range
2–5 digits

Feature Manual References
2.3.16 Mailbox

First Name
Specifies the first name of the subscriber.

If there are non-alphabetical characters in the first 4 letters of the first name, the mailbox is not 
included in the directory.

Default
None

Value Range
Max. 20 characters ("\", "^", "`" and "˜" cannot be used.)

Programming Manual References
"Directory Listing" in 2.2.2 Personal Options

Feature Manual References
2.2.18 Dialing by Name

Last Name
Specifies the last name of the subscriber.

If there are non-alphabetical characters in the first 4 letters of the last name, the mailbox is not 
included in the directory.

Default
None
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Value Range
Max. 20 characters ("\", "^", "`" and "˜" cannot be used.)

Programming Manual References
"Directory Listing" in 2.2.2 Personal Options

Feature Manual References
2.2.18 Dialing by Name

Password
Specifies the password needed to access the mailbox. If a default password is programmed by the 
System Administrator, that password will be assigned automatically when creating all mailboxes. The 
System Administrator can change and delete the password.

Follow the steps below to edit Password:

1. Click "Click to change password...".

2. Set the new password, or delete the current password.

To set the new password:

a) Enter the new password, then confirm the new password by re-entering it.

b) Click OK, then click OK to close the Mailbox Parameters window.

To delete the current password:

a) Click OK without entering a password.
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b) Click Yes when the warning is displayed, then click OK to close the Mailbox 
Parameters window.

Note

• Each subscriber can change his or her mailbox password.

Default
None

Value Range
Max. 16 digits

Programming Manual References
2.8.2 Subscriber

Subscriber's Manual References
2.4 Changing or Deleting Your Password

Class of Service
Determines the set of services available to the subscriber.

Note

• We recommend that parameters for each COS number be defined before assigning a Class 
of Service (COS) to each mailbox or creating new mailboxes.

• COS No. 63 and 64 are assigned by default to the Message Manager and to the System 
Manager, respectively. No other mailboxes can be assigned to COS No. 63 and 64.

Default
1

Value Range
COS No. 1–62

Programming Manual References
2.2 Class of Service

Feature Manual References
2.2.12 Class of Service (COS)

Covering Extension
Forwards calls to a second extension when the first extension's subscriber is not available to take the 
call. The Covering Extension is one of the Incomplete Call Handling options that can be enabled or 
disabled by the subscriber. The caller can also be transferred the Covering Extension by pressing [0] 
while a Personal Greeting is being played, or while leaving a message.

Note

• Extension Group Lists or Logical Extensions (extensions whose calls are set to always be 
directed their mailboxes) cannot be assigned as covering extensions.
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Default
None

Value Range
2–5 digits

Feature Manual References
2.2.15 Covering Extension

Subscriber's Manual References
5.3 Assigning Your Covering Extension

Interview Mailbox
Assigns an interview mailbox to the subscriber's mailbox. In order for it to function properly, the 
interview mailbox number must not be the same number as an existing mailbox and an existing 
mailbox group.

Note

• Each caller's replies to an interview session are saved as one message.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.26 Interview Service

Subscriber's Manual References
5.4 Interview Mailbox

All Calls Transfer to Mailbox
If this parameter is set to "Yes", the extension is considered to be a "Logical Extension" and therefore 
calls directed to the extension via Automated Attendant service are automatically forwarded to the 
extension mailbox. The extension does not ring when a call is received.

Note

• When this feature has been set to "Yes", the mailbox subscriber's extension does not 
necessarily need to exist as an extension of the PBX.

Default
No

Value Range
No, Yes
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Feature Manual References
2.2.3 Automated Attendant

Call Transfer Sequence
Specifies the Call Transfer Sequence used by the mailbox. Allows each mailbox to be assigned its 
own Call Transfer Sequence (Personal Transfer Sequence). 

Note

• When "System" is selected, the VPS follows the "Extension Transfer Sequence" 
preprogrammed for the VPS in the "System Parameters→Parameters→PBX 
Parameters→PBX Environment".

• This sequence has higher priority than "Alternate Extension Transfer Sequence" in 2.5.4 
Parameters.

Default
System

Value Range
System

Max. 16 characters consisting of 0–9, , # and special codes:

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

, : Dial Pause (default 1 s)

; : Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Programming Manual References
"Extension Transfer Sequence" in 2.5.4 Parameters

Feature Manual References
2.3.5 Call Transfer Status

No Answer Time
Specifies the length of time that the VPS waits before handling unanswered calls to the extension.

Note

• When "System" is selected, the VPS follows the "Call Transfer No Answer Time" 
preprogrammed for the VPS in the "System Parameters→ Parameters→ Dialing 
Parameters".

Default
System
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Value Range
System, 10 s – 60 s

Programming Manual References
"Call Transfer No Answer Time" in 2.5.4 Parameters

Call Transfer Status
Determines how the VPS handles a call when it reaches the subscriber's extension.

Note

• This setting can be changed by subscribers.

Default
None

Value Range
Select:

None: rings the subscriber's extension

Call blocking: connects the caller to the Incomplete Call Handling Service without ringing the 
subscriber's extension.

Call screening: the caller is prompted to record his or her name. The VPS then calls the 
subscriber and plays back the caller name. The subscriber can choose whether to answer the 
call.

Intercom paging: pages the subscriber by intercom.

Calling a beeper: notifies the subscriber via a beeper.

Transfer to mailbox: transfers the caller to the mailbox.

Transfer to specified custom service menu: transfers the caller to the specified Custom Service.

Transfer to specified telephone number: transfers the caller to the specified telephone number.

Feature Manual References
2.3.5 Call Transfer Status

Subscriber's Manual References
5.1 Call Transfer

Incomplete Call Handling for No Answer
Specifies how the VPS handles a call when there is no answer.

Note

• This setting can be changed by subscribers.

• More than one option can be selected.

Default
Leave a message/Transfer to operator/Return to top menu
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Value Range
Leave a message: allows the caller to record a message.

Transfer to a covering extension: transfers the caller to a covering extension.

Page the mailbox owner by Intercom Paging: pages the subscriber by intercom.

Notify the mailbox owner via a beeper: notifies the subscriber via a beeper.

Transfer to operator: transfers the caller to an operator.

Return to top menu: lets the caller return to top menu and try another extension.

Transfer to specified Custom Service menu: transfers the caller to the specified Custom 
Service.

Feature Manual References
2.3.14 Incomplete Call Handling Service

Subscriber's Manual References
5.2 Incomplete Call Handling

Incomplete Call Handling for Busy
Specifies how the VPS handles a call when the extension is busy.

Note

• This setting can be changed by subscribers.

• More than one option can be selected.

Default
Leave a message/Transfer to operator/Return to top menu

Value Range
Leave a message: allows the caller to record a message.

Transfer to a covering extension: transfers the caller to a covering extension.

Page the mailbox owner by Intercom Paging: pages the subscriber by intercom.

Notify the mailbox owner via a beeper: notifies the subscriber via a beeper.

Transfer to operator: transfers the caller to an operator.

Return to top menu: lets the caller return to top menu and try another extension.

Transfer to specified Custom Service menu: transfers the caller to the specified Custom 
Service.

Feature Manual References
2.3.14 Incomplete Call Handling Service

Subscriber's Manual References
5.2 Incomplete Call Handling
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2.1.4 Notification Parameters

The VPS is able to notify a subscriber when a new message is recorded in his or her mailbox. There 
are 2 methods that the VPS can use for Message Waiting Notification: (1) by lighting the Message 
Waiting Lamp on the subscriber's extension telephone and (2) by calling a preprogrammed device 
(i.e., external telephone or beeper). A maximum of 3 devices (Device 1,2,3) can be programmed per 
mailbox.

Message Waiting Lamp
If set to "Enable", the Message Waiting Lamp of the subscriber's telephone turns on when a new 
message is recorded.

Default
Enable

Value Range
Disable, Enable

Feature Manual References
2.2.32 Message Waiting Notification—Lamp
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Beeper Callback No. Entry Mode
This feature allows a caller to dial his or her own telephone number, which the VPS then sends to the 
subscriber's beeper.

Note

• To use this feature, the callback number entry code "X" must be programmed along with the 
subscriber's beeper number. If the caller does not enter a callback number, or if this feature 
is set to "Disable", the "System Callback No." (set in "System Parameters→ 
Parameters→Message Waiting Notification") will be displayed on the beeper's display 
instead. In either of these cases, if a caller's telephone number is received through the 
telephone company's Caller ID service, the VPS will send the caller's number to the beeper 
instead of the "System Callback No.".

Default
Disable

Value Range
Caller Select: After recording a message, the caller is asked whether or not he or she wishes to enter 
a callback number.

Without: Without recording a message, the caller is asked to enter a callback number.

Before: Before recording a message, the VPS asks the caller to enter a callback number. 

After: After recording a message, the VPS asks the caller to enter a callback number.

Disable: Disables the Callback Number Entry feature. Either the caller's telephone number received 
by through the telephone company's Caller ID service or the "System Callback No." will be sent to the 
beeper.

Programming Manual References
"System Callback No." in 2.5.4 Parameters

Feature Manual References
2.3.8 Calling a Beeper

Device Notification for Unreceived Message
This parameter determines what happens if Message Waiting Notification—Device begins but is 
interrupted for some reason (i.e., the subscriber hangs up without listening to all new messages, the 
subscriber's cell phone disconnects while listening to messages, etc.). 
If this parameter is set to "Yes", the VPS will try to call the lowest numbered device again. 
If this parameter is set to "No", the VPS will call the lowest numbered device only after another new 
message is recorded in the mailbox.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.31 Message Waiting Notification—Device
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Notification Schedule
Specifies the Message Waiting Notification schedule for each device. The following parameters can 
be specified per device.

Follow the steps below to edit Notification Schedule:

1. Click Click to edit….

2. Select a device (Device No. 1, Device No. 2, Device No. 3) tab.

3. Edit parameters.

4. Click OK.

Notification Type
Specifies the type of message for which notification is sent. Notification can be sent for all messages, 
or urgent messages only.

Default
All Messages

Value Range
All Messages, Only Urgent Messages

Feature Manual References
2.2.31 Message Waiting Notification—Device
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2.1 Mailbox Settings
Dial Number
Assigns a telephone or beeper number to Device 1, 2, or 3. The subscriber can also specify the 
number to be dialed by entering it from his or her telephone, allowing the subscriber to set this feature 
on a case by case basis.

Note

• The callback number entry code "X" must be included in the number to be called if the 
"Beeper Callback No. Entry Mode" is set to any values other than "Disable" (see "Beeper 
Callback No. Entry Mode") and "Type of Device" is set to "Beeper". The proper "Dial Pauses" 
must be inserted before the callback entry code.

• When the VPS calls a trunk (CO line) via a PRI (ISDN Primary Rate Access Interface) card 
of a Panasonic PBX, please be sure to add "#" after the telephone number (1112223333 in 
the example here):  
Example: 9P1112223333#PP123PP456PPX# (P: Dial Pause)

Default
None

Value Range

Max. 32 digits consisting of 0–9, , # and special codes:

, : Dial Pause (default 1 s)

; : Dial Pause (default 3 s)

T: Dial Tone Detection

X: Callback Number Entry Code

0–9, , #: Dial Codes

Feature Manual References
2.2.31 Message Waiting Notification—Device

Type of Device
Specifies the type of device telephone or beeper that will receive message notification. The 
subscriber can also specify the type of device from his or her telephone.

Default
Telephone

Value Range
Telephone, Beeper

Feature Manual References
2.2.31 Message Waiting Notification—Device

No. of Retries
Specifies the number of times the VPS will try to send notification if the device is busy or if there is no 
answer.
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2.1 Mailbox Settings
Default
0

Value Range
0-9 times

Note

• The value range varies depending upon country/area.

Feature Manual References
2.2.31 Message Waiting Notification—Device

Busy Delay Time
Specifies the time (in minutes) the VPS waits before retrying message notification when the called 
device is busy.

Default
3 min

Value Range
0 min–120 min

Note

• The value range varies depending upon country/area.

Feature Manual References
2.2.31 Message Waiting Notification—Device

No Answer Delay Time
Specifies the time (in minutes) the VPS waits before retrying message notification when the called 
device does not answer.

Default
60 min

Value Range
60 min–120 min

Note

• The value range varies depending upon country/area.

Feature Manual References
2.2.31 Message Waiting Notification—Device
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2.1 Mailbox Settings
Use Mode
Specifies if and how each device is used for message notification. The subscriber can also specify 
the use mode from his or her telephone.

Default
Continuously

Value Range
Not Use: The selected device is not used for message notification.

Continuously: The device is called whenever a message is recorded in the mailbox. If "Notification 
Type" is set to "Only Urgent Messages" , the device is called whenever an urgent message is 
recorded in the mailbox.

Scheduled: The selected device is called only during the selected times.

Feature Manual References
2.2.31 Message Waiting Notification—Device

Time Frame 1, 2 (MON–SUN)
Specifies the schedule (time frame) of Message Waiting Notification by the selected device for each 
day of the week when "Scheduled" is set in "Use Mode". Notification will be sent for messages 
received during the time frame set here. For messages received during times outside of the time 
frame, notification will be sent at the beginning of the next time frame.

Follow the steps below to edit Time Frame:

1. Click a day (Sunday – Saturday) tab.

2. Click "Time Frame 1" or "Time Frame 2".

3. Enter the start and end times in the "Start At:" and "End At:" fields, or drag the edges of the time 
frame to mark the start and end times.

To copy the schedule of one day to another day

1. Select a time frame in the desired "copy from" day.

2. Click Copy.

3. Select a time frame in the desired "copy to" day.

4. Click Paste.

4. Click OK.

Default
Time Frame 1: 02:00-11:00

Time Frame 2: 13:00-22:00

Value Range
00:00–23:59

Feature Manual References
2.2.31 Message Waiting Notification—Device
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2.1 Mailbox Settings
Device Notification Timer
Specifies the delay time for Message Waiting Notification per device.

Device Start Delay Time
Specifies the length of time the VPS waits after a new message is received before sending message 
waiting notification.

Default
0 min

Value Range
0 min–120 min

Feature Manual References
2.2.31 Message Waiting Notification—Device

Device Interval Time between Device 1 and Next Device
Specifies how long the PBX waits after sending Message Waiting Notification to Device 1 before 
sending notification to the next device.

Default
0 min

Value Range
0 min–120 min

Feature Manual References
2.2.31 Message Waiting Notification—Device

Device Interval Time between Device 2 and Next Device
Specifies how long the PBX waits after sending Message Waiting Notification to Device 2 before 
sending notification to the next device.

Default
0 min

Value Range
0 min–120 min

Feature Manual References
2.2.31 Message Waiting Notification—Device
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2.1 Mailbox Settings
Device Interval Time between Device 3 and Next Device
Specifies how long the PBX waits after sending Message Waiting Notification to Device 3 before 
sending notification to the next device.

Default
0 min

Value Range
0 min–120 min

Feature Manual References
2.2.31 Message Waiting Notification—Device
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2.1 Mailbox Settings
2.1.5 External Message Delivery

Allows a subscriber to send a message to several subscribers and non-subscribers (including outside 
parties) immediately or at a specified time.

Active
If set to "Yes", subscribers are able to utilize the External Message Delivery feature.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.11 External Message Delivery Service

Subscriber's Manual References
5.7 External Message Delivery Lists
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2.1 Mailbox Settings
Prompt Mode
When an external message is delivered, the receiver will be greeted by the VPS in the specified 
language (prompt). If set to "Primary", the default language will be used, then, If set to "Selective", 
the receiver has a choice of prompts. See related explanation in "Incoming Call Service Prompt" in 
2.3.1 Service Group.

Note

• If set to "Selective" and the receiver uses a rotary telephone, the no-entry selection is 
specified by "Prompt for Rotary Callers" in 2.3.1 Service Group.

Default
Primary

Value Range
Primary, Selective, Selection from all installed languages (KX-TVA50: 3 languages, KX-TVA200: 10 
languages)

Programming Manual References
"Incoming Call Service Prompt" in 2.3.1 Service Group

Feature Manual References
2.2.44 System Prompts
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2.1 Mailbox Settings
2.1.6 Auto Forwarding

Moves or copies unplayed messages from one mailbox to another, after a specified period of time. 
This service is only available to subscribers (you cannot auto forward messages to a Mailbox Group).

Active
If set to "Yes", the VPS automatically forwards messages that have not been played for a specified 
length of time to another mailbox.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.2 Auto Forwarding

Mailbox Number
Specifies the mailbox to which the messages will be forwarded.
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2.1 Mailbox Settings
Note

• A Mailbox Group number cannot be specified as a destination.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.2 Auto Forwarding

Delay Time
Specifies the length of time in hours and minutes that the VPS waits before forwarding unplayed 
messages. The maximum delay time is 99 h, 59 min.

Note

• The delay time must be shorter than the New Message Retention Time, or else messages 
will be deleted before being forwarded.

Default
00:30

Value Range
00:05–99:59

Feature Manual References
2.2.2 Auto Forwarding

Forwarding Mode
Specifies if forwarded messages are to be retained in the original mailbox. When set to "Copy", copies 
of the messages are retained in the original mailbox after forwarding. When set to "Move", messages 
are forwarded to the receiving mailbox and are not retained in the original mailbox.

Default
Move

Value Range
Copy, Move

Feature Manual References
2.2.2 Auto Forwarding
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2.1 Mailbox Settings
2.1.7 Personal Distribution List

Personal Distribution Lists are used to send the same messages to several mailboxes in a single 
operation. A maximum of 4 lists can be maintained with each list containing a maximum of 40 
mailboxes.

List No. 1–List No. 4

List Name
Specifies a list name.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.3.12 Group Distribution List—Personal
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2.1 Mailbox Settings
List Members
Specifies the mailbox numbers that belong to the list.

Follow the steps below to edit List Members:

1. Click Click to edit….

[Addition]

1. Enter a mailbox number in Quick Search Mailbox: or select the mailbox number in the 
Subscribers to add table.

2.  Click Add>>.

[Deletion]

1. Enter a mailbox number in Quick Search Mailbox: or select the mailbox number in the 
Distribution table.

2. Click Delete<<.

[Searching]

1. Click Search Subscribers….

2. Enter the Mailbox No., Extension No., First Name, or Last Name of the desired subscriber.

3. Click OK.

Default
None

Value Range
Max. 40 mailboxes

Feature Manual References
2.3.12 Group Distribution List—Personal

Subscriber's Manual References
5.6 Personal Group Distribution Lists
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2.1 Mailbox Settings
2.1.8 Personal Custom Service

Personal Custom Service
Specifies the Personal Custom Service. The System Administrator can assign an operation to each 
key.

Note

• These settings can be changed by subscribers.

• Make sure to add a Trunk (CO Line) Access number when you store an outside telephone 
number.

• When the VPS calls a trunk (CO line) via a PRI (ISDN Primary Rate Access Interface) card 
of a Panasonic PBX, please be sure to add "#" after the telephone number (1112223333 in 
the example here): 
Example: 9P1112223333#PP123PP456PPX# (P: Dial Pause)

Follow the steps below to edit Personal Custom Service:

1. Click Click to Edit….
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2.1 Mailbox Settings
Key Assignment

1. Select the desired key.

2. Assign the operation in Assigned Operation and enter the setting in Value according to the 
operation.

Outside Numbers

1. Enter outside numbers to be transferred.

2. Select "Recording", "Disconnect (All Day)", or "Disconnect (Only After Hours)" for No DTMF 
Input Operation.

2. Click OK.

Default
<Key Assignment>

0: None

3–9: None

<Outside Numbers>

Outside Number #1–#4: None

No DTMF Input Operation: Message Recording
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2.1 Mailbox Settings
Value Range
<Key Assignment>

Key: 3–9, 0

Assigned Operation:

Transfer to specified mailbox: Allow the caller to leave messages in a specified mailbox.

Transfer to specified extension: Transfers the caller to a specified extension.

Transfer to Voice Mail Service: Allows the caller to access Voice Mail Service.

Transfer to Automated Attendant Service: Allows the caller to access Automated Attendant 
Service.

Transfer to specified Custom Service menu: Transfers the caller to the Custom Service 
specified here.

Transfer to operator: Connects the caller to an operator.

Transfer to outside (specified number): Transfers the caller to a specified outside telephone 
number. Enter the PBX Trunk (CO Line) Access Number such as 9.

Page the party: Pages the subscriber.

Repeat greeting: Repeats the greeting.

None: No operation assigned

<Outside Numbers>

Outside Number #1–#4: Max. 32 digits consisting of 0–9, , #, and special codes

T: Dial Tone Detection

, : Dial Pause (default 1 s)

; : Dial Pause (default 3 s)

0–9, , #: Dial Code

 
No DTMF Input Operation: Recording, Disconnect (All Day), Disconnect (Only After Hours)

Feature Manual References
2.3.20 Personal Custom Service

Subscriber's Manual References
5.17 Personal Custom Service
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2.1 Mailbox Settings
2.1.9 Remote Call FWD to CO

Specifies the telephone numbers of destinations to which callers are forwarded when the subscriber 
sets "Remote Call Forwarding to a Trunk". 2 telephone numbers can be specified per mailbox.

Note

• Class of Service programming determines if the subscriber is able to use this feature.

• The Remote Call FWD to CO is only available when the VPS is connected to a Panasonic 
KX-T series PBX using DPT Integration.

Telephone Number 1, 2
Specifies the telephone numbers of destinations to which callers are forwarded when the subscriber 
sets "Remote Call Forwarding to a Trunk". Telephone numbers can contain the digits "0-9" and " ". 
These telephone numbers should begin with a Trunk (CO Line) Access number.

Default
None

Value Range
Max. 24 digits (With the KX-TD500 and KX-TDA/KX-TAW series)

Max. 16 digits (With other KX-T series PBXs)
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2.1 Mailbox Settings
Programming Manual References
"Remote Call Forward to CO" in 2.2.2 Personal Options

Feature Manual References
2.3.27 Remote Call Forwarding Set (DPT Integration Only)

Subscriber's Manual References
5.14 Remote Call Forwarding
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2.1 Mailbox Settings
2.1.10 Automatic Log-in

Allows subscribers to access their mailbox directly without entering the mailbox number. Subscribers 
can automatically log in either from their extensions, or from outside phones by dialing a 
preprogrammed Caller ID number, DID number, or by dialing a telephone number specified to a 
preprogrammed trunk (CO line). When logging in from outside phones, the Toll Saver feature is also 
available.

Extension
If set to "Enable", subscribers are able to access their mailbox directly without entering the mailbox 
number.

Default
Enable

Value Range
Disable, Enable

Feature Manual References
2.3.2 Automatic Log-in (APT/DPT Integration Only)
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2.1 Mailbox Settings
Caller ID 1, 2
Specifies the telephone number from which the subscriber can automatically be logged in from. When 
Caller ID information is received that matches one of these numbers, the caller (subscriber) is 
automatically logged in to the mailbox. Note that this telephone number must be unique for each 
mailbox.

Default
None

Value Range
Max. 20 digits

Feature Manual References
2.3.2 Automatic Log-in (APT/DPT Integration Only)

Subscriber's Manual References
5.16 Assigning Your Telephone Numbers for Remote Automatic Log-in and Toll Saver

DID
Specifies the DID number for Automatic Log-in. When the VPS receives this DID number from the 
PBX, the caller (subscriber) is automatically logged in to the mailbox. Note that this number must be 
unique for each mailbox.

Note

• Automatic Log-in via DID number is only available when the VPS is connected to one of the 
following PBXs using DPT Integration.

– KX-TD816 (P311Q or higher)

– KX-TD1232 (P211Q or higher)

– KX-TD500 (V4M or higher)

– KX-TDA series* (MPR Version 1.1 or higher) 
* except KX-TDA50

Default
None

Value Range
Max. 20 digits

Feature Manual References
2.3.2 Automatic Log-in (APT/DPT Integration Only)

Subscriber's Manual References
5.16 Assigning Your Telephone Numbers for Remote Automatic Log-in and Toll Saver
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2.1 Mailbox Settings
Trunk
Specifies the trunk (CO line) number for Automatic Log-in. When the VPS receives a call on this trunk 
(CO line), the caller (subscriber) is automatically logged in to the mailbox. Note that this number must 
be unique for each mailbox.

Default
None

Value Range
1–64

Feature Manual References
2.3.2 Automatic Log-in (APT/DPT Integration Only)

Toll Saver
Allows a subscriber to check his or her mailbox from preprogrammed Caller ID numbers specified for 
Automatic Log-in, by dialing a preprogrammed DID Number specified for Automatic Log-in, or the 
telephone number assigned to the trunk (CO line) specified for Automatic Log-in without incurring 
telephone charges.

Default
Disable

Value Range
Disable: Disables the Toll Saver feature.

DID: Toll Saver functions when the VPS receives the preprogrammed DID number from the PBX.

Caller ID: Toll Saver functions when Caller ID information is received that matches one of the 
preprogrammed numbers (Caller ID 1 or 2)

Trunk: Toll Saver functions when the VPS receives a call on the preprogrammed trunk (CO line).

Feature Manual References
2.3.2 Automatic Log-in (APT/DPT Integration Only)
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2.1 Mailbox Settings
2.1.11 E-mail Option

Enables subscribers to receive Message Waiting Notifications by e-mail when they receive new 
messages.

Follow the steps below to edit E-mail Option:

1. Click Add Mailbox... or select a mailbox and click Edit Mailbox....

2. Enter the user name for the subscriber's e-mail account next to Username.

3. Enter the subscriber's e-mail address next to E-mail Address. Up to 3 addresses can be set by 
inserting a comma between each address.

4. Set Send E-mail with New Messages to Enable to allow the subscriber to receive e-mail 
notifications.

5. Set Attach Voice File to Enable to allow the subscriber to receive voice messages as e-mail file 
attachments.

6. Click Click to edit… next to E-mail Schedule to determine when e-mail messages are sent, and 
make the appropriate settings.

7. Click OK when finished.

Username
Specifies a subscriber's user name for e-mail option.
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2.1 Mailbox Settings
Default
None

Value Range
Max. 64 characters

Feature Manual References
2.2.20 E-mail Integration

E-mail Address
Specifies the subscriber's e-mail address. Up to 3 addresses can be set (with a comma inserted 
between addresses).

Default
None

Value Range
Max. 128 characters

Feature Manual References
2.2.20 E-mail Integration

Send E-mail with New Messages
If set to "Enable", the subscriber is able to receive notification by e-mail.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.20 E-mail Integration

Attach Voice File
If set to "Enable", the subscriber is able to receive voice messages by e-mail (messages are sent as 
file attachments).

Default
Disable

Value Range
Disable, Enable
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2.1 Mailbox Settings
Feature Manual References
2.2.20 E-mail Integration

E-mail Schedule
Specifies the schedule (time frame) of Message Waiting Notification by e-mail for each day of the 
week, and specifies whether to delete the original message in a mailbox after the message attached 
to an e-mail is sent. Notification will be sent for messages received during the time frame set here. 
For messages received during times outside of the time frame, notification will be sent at the 
beginning of the next time frame. 
You can also set Notification schedule to "All Day" or "No Use".

Follow the steps below to edit Time Frame:

1. Click a day (Sunday – Saturday) tab.

2. Uncheck "All Day" or "No Use" if checked.

3. Click "Time Frame".

4. Enter the start and end times in the "Start At:" and "End At:" fields, or drag the edges of the time 
frame to mark the start and end times.

To copy the schedule of one day to another day

1. Select a time frame in the desired "copy from" day.

2. Click Copy.

3. Select a time frame in the desired "copy to" day.

4. Click Paste.

5. Check "Delete After Send" if needed.

6. Click OK.

Default
All Day

Value Range
00:00–23:59

Feature Manual References
2.2.20 E-mail Integration
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2.2 Class of Service
2.2 Class of Service
Each mailbox is assigned a Class of Service (COS) that determines the set of services that are 
available to its subscriber. There are 64 classes. Mailboxes can be assigned to their own or to the 
same COS as needed. COS No. 63 and 64 are assigned by default to the Message Manager and to 
the System Manager, respectively. No other mailboxes can be assigned to COS No. 63 and 64.

Follow the steps below to edit Class of Service:

[Edit]

1. Select the desired COS No. from COS No..

2. Edit each parameter in the dialog box.

3. Click OK.

[Copy]

1. Select the desired COS No. to copy, and press Copy.

2. Copy Class of Service window is displayed. Check the items to copy, and select the 
destination COS number. (Ctrl/Shift key is available to choose several mailbox COS 
numbers.)

3. Click OK.

[Report View]

1. Select the desired COS No..

2. Click Report View.
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2.2 Class of Service
Displays parameters for all COS settings. Classes of Service can be sorted in ascending or 
descending order by parameter by clicking the parameter name. 
From this screen, you cannot edit any parameters: to edit each setting, click the desired COS 
No., then press Edit COS.

2.2.1 Class of Service

Specifies the parameters for each Class of Service.

Class of Service Name
Specifies the Class of Service's name.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.12 Class of Service (COS)

Personal Greeting Length
Defines the maximum length (in seconds) of the Personal Greeting.

Default
60 s
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2.2 Class of Service
Value Range
1 s–360 s 

Feature Manual References
2.3.22 Personal Greetings

Message Length
Defines the maximum recording time for messages. If set to "Unlimited", the maximum recording time 
is 60 minutes, and the maximum recording time for two-way conversations (Two-way Record and Two-
way Transfer) is unlimited.

Default
COS 1-62: 3 min

COS 63-64: 10 min (KX-TVA50), 60 min (KX-TVA200)

Value Range
1 min–60min, Unlimited

Feature Manual References
2.3.32 Two-way Record (APT/DPT Integration Only)

2.3.33 Two-way Transfer (APT/DPT Integration Only)

Subscriber's Manual References
5.13 Recording Your Conversations

Mailbox Capacity Maximum Message Time
Specifies the total number of available minutes for storing messages (both new and saved) in each 
mailbox.

Default
COS 1-62: 10 min (KX-TVA50), 100 min (KX-TVA200)

COS 63-64: 120 min (KX-TVA50), 600 min (KX-TVA200)

Value Range
For KX-TVA50: 1 min–120 min, Unlimited

For KX-TVA200: 1 min–600 min, Unlimited

New Message Retention Time
Defines the number of days that a new message will remain in the mailbox. The storage period begins 
the day after the message reception. If "Unlimited" is selected, the saved message will remain in the 
mailbox until erased by the subscriber.

Default
30 days
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2.2 Class of Service
Value Range
1–30 days, Unlimited

Saved Message Retention Time
Defines the number of days that a played message will remain in the mailbox. The timing is 
"refreshed" whenever the message is played back. If "Unlimited" is selected, the saved message will 
remain in the mailbox until erased by the subscriber.

Default
30 days

Value Range
1–30 days, Unlimited

Message Retrieval Order
Specifies the order in which messages will be retrieved (played back for listening).

Default
LIFO

Value Range
LIFO: Messages are retrieved starting with the most recent (Last In First Out).

FIFO: Messages are retrieved starting with the oldest (First In First Out).

Intercom Paging Group
Specifies the Intercom Paging group number available to the subscriber.

Note

• The Intercom Paging feature is only available when the VPS is connected to a Panasonic 
KX-T series PBX using APT/DPT Integration.

• "Intercom paging Parameters" can be edited by clicking Edit System Parameters/
Parameters/Intercom Paging Parameters at the bottom of COS Parameters  window.

Default
1

Value Range
1–32, All

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Prompt Mode
Specifies the language used for system prompts played for the subscriber during Subscriber Service.

If set to "Primary", the default language which is selected from all installed languages will be used.
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2.2 Class of Service
Note

• If a certain prompt is not recorded in the language selected by the subscriber, the English 
version of that prompt will be used.

Default
Primary

Value Range
Primary, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Feature Manual References
2.2.33 Multilingual Service

2.2.44 System Prompts

Number of CIDs for Caller Name Announcement
Specifies the maximum number of Caller IDs which subscribers can assign for the Personal Caller 
Name Announcement.

Default
30

Value Range
None, 1–30

Feature Manual References
2.2.10 Caller Name Announcement—Personal (APT/DPT Integration Only)

Subscriber's Manual References
5.11 Personal Caller Name Announcement

Message Envelope Setting
Specifies when message envelopes (message date and time, name of the person who recorded or 
transferred the message, telephone number of the caller) are announced.

Note

• If you want to skip this information, press [6] while listening to it.

Default
After

Value Range
Before: The VPS announces Message Envelope before playing the recorded message.

After: The VPS announces Message Envelope after playing the recorded message.

Require: The VPS announces Message Envelope when it is required by DTMF command.
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2.2 Class of Service
Number of New Messages Announcement
Specifies the position of the Number of New Messages Announcement.

Default
Subscriber Service

Value Range
None: Not announced

Subscriber Service: The VPS announces the number of new messages at the beginning of 
Subscriber Service (i.e., after the subscriber has logged in to his or her mailbox).

Receiving Messages: The VPS announces the number of new messages after the subscriber has 
selected to listen to messages while accessing his or her mailbox.

Total Number of Message Announcement
Specifies the position of the Total Number of Messages Announcement.

Note

• When the same position is set for the Number of New Messages Announcement and the 
Total Number of Message Announcement, the VPS announces the number of new 
messages then the total number of messages.

Default
Receiving Messages

Value Range
None: Not announced

Subscriber Service: The VPS announces the number of new messages at the beginning of 
Subscriber Service.

Receiving Messages: The VPS announces the number of new messages at the beginning of 
Receive Message Service.

Mailbox Capacity Warning
Specifies if and when the VPS alerts subscribers when recording time for their mailboxes is running 
low. If set to "None", the warning will not be announced. All other settings indicate the remaining 
recording time capacity threshold for when the announcement is heard.

Default
10 min

Value Range
None, 1–60 min

Feature Manual References
2.3.17 Mailbox Capacity Warning

Subscriber's Manual References
5.21 Mailbox Capacity Warning
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2.2 Class of Service
2.2.2 Personal Options

The following parameters determine the utilization of features in each mailbox based on the COS.

VM Menu
If set to "Yes", the subscriber can use the VM Menu feature.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.36 VM Menu (DPT Integration Only)

Subscriber's Manual References
1.1 Introduction to the VPS

Play System Prompt after Personal Greeting
If set to "Yes", directions for recording a message are given to the caller immediately after the 
personal greeting has been played.

Default
No
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2.2 Class of Service
Value Range
No, Yes

Use Call Waiting on Busy
If set to "Yes", the VPS signals the subscriber when he or she is on a call and another call is received.

Note

• "Call Waiting Sequence" can be edited by clicking Edit System Parameters/Parameters/
Call Waiting Sequence at the bottom of the dialog box.

Default
No

Value Range
No, Yes

Message Cancel for Live Call Screening
If set to "Yes", the caller's message will be deleted when the subscriber answers a call via Live Call 
Screening while the caller is leaving a message.

Note

• The Live Call Screening feature is only available when the VPS is connected to a Panasonic 
KX-T series PBX using APT/DPT Integration.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.15 Live Call Screening (APT/DPT Integration Only)

Subscriber's Manual References
5.12 Live Call Screening (LCS)

Remote Call Forward to CO
If set to "Yes", the subscriber can use the Remote Call Forwarding feature. This feature allows the 
subscriber to program his or her extension remotely to forward calls to an outside telephone number. 
This telephone number can be "Telephone No. 1" or "Telephone No. 2" (in 2.1.9 Remote Call FWD to 
CO), or any other telephone number.

Note

• The Remote Call FWD to CO feature is only available when the VPS is connected to a 
Panasonic KX-T series PBX using DPT Integration.

• The FWD to CO feature may be prohibited by the PBX; PBX programming may also be 
necessary to enable this feature for the COS of the extensions who will use this feature.
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2.2 Class of Service
Default
No

Value Range
No, Yes

Programming Manual References
2.1.9 Remote Call FWD to CO

Feature Manual References
2.3.27 Remote Call Forwarding Set (DPT Integration Only)

Subscriber's Manual References
5.14 Remote Call Forwarding

Delete Message Confirmation
If set to "Yes", the VPS requests confirmation from the subscriber before erasing a message in the 
mailbox. If set to "No", the message is erased immediately.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.9 Delete Message Confirmation

Personal Greeting for Caller ID
If set to "Yes", subscribers can record personal greetings that are played for specific callers only 
(Personal Greeting for Caller ID).

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.21 Personal Greeting for Caller ID (APT/DPT Integration Only)

Subscriber's Manual References
5.10 Personal Greeting for Caller ID
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2.2 Class of Service
Caller ID Screen
If set to "Yes", subscribers can hear the prerecorded names of callers when they receive calls (Caller 
ID Screening).

Default
Yes

Value Range
No, Yes

Feature Manual References
2.2.9 Caller ID Screening (APT/DPT Integration Only)

Caller ID Callback
If set to "Yes", the subscriber can call the caller back while listening to the caller's message (Caller ID 
Callback).

Default
No

Value Range
No, Yes

Feature Manual References
2.3.7 Caller ID Callback (APT/DPT Integration Only)

Notify of Transfer
If set to "Yes", subscribers will hear "You have a call." when they answer transferred calls.

Default
No

Value Range
No, Yes

Directory Listing
If set to "Yes", the subscriber's name and extension number will be listed in the directory (Dialing by 
Name).

Default
Yes

Value Range
No, Yes
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2.2 Class of Service
Feature Manual References
2.2.18 Dialing by Name

Tutorial
If set to "Yes", subscribers are guided to set the following basic mailbox settings when they access 
their mailboxes for the first time:

– Password

– Owner's Name

– No Answer Greeting

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.28 Subscriber Tutorial

Subscriber's Manual References
2.2 Subscriber Tutorial (Easy Mailbox Configuration)

Auto Receipt
If set to "Yes", the subscriber can request to receive confirmation when his or her message has been 
listened to by the message recipient.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.1 Auto Receipt

Autoplay New Message
If set to "Yes", the VPS plays new messages automatically when the subscriber logs into his or her 
mailbox.

Default
No

Value Range
No, Yes
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2.2 Class of Service
Feature Manual References
2.3.3 Autoplay New Message

First Playback Urgent Messages
If set to "Yes", the VPS plays urgent messages before regular messages.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.35 Urgent Message

Announce Message Transferred Information
If set to "Yes", the VPS plays the information of transferred messages to a subscriber before playing 
the messages.

Default
Yes

Value Range
No, Yes

Caller ID Number Announcement
Specifies whether or not the VPS announces the Caller ID number when the subscriber plays a 
message left by a caller whose name has not been recorded for the Caller Name Announcement 
feature. If the name has been recorded, it will be announced regardless of this setting.

Default
Yes

Value Range
No, Yes

Announce Option Menu After Erasing Messages
If set to "Yes", the VPS plays the option menu after erasing a message. If set to "No", the VPS plays 
the next message automatically without playing the option menu.

Default
Yes
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2.2 Class of Service
Value Range
No, Yes

Call Transfer to Outside
If set to "Yes", the VPS allows calls to be transferred to a trunk (CO line) via the following features: 
Caller ID Callback, Call Transfer Service, and Personal Custom Service.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.7 Call Transfer to Outside

New Message Length Announcement
If set to "Yes", the VPS announces the total length of new messages when the number of new 
messages is announced.

Default
No

Value Range
No, Yes
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2.3 Port/Trunk Service
2.3 Port/Trunk Service
When a call is received from an outside party, the following call services can determine how the call 
is handled:

– Automatic Log-in (Toll Saver)

– Holiday Service

– Caller ID Call Routing

– DID Call Routing

– Trunk Service

– Port Service

 
The service with the highest priority will handle the call. The order of priority is:

Automatic Log-in (Toll Saver) > Holiday Service > Caller ID Call Routing > DID Call Routing > Trunk 
Service > Port Service.
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2.3 Port/Trunk Service
2.3.1 Service Group

A Service Group Is a group of parameters that determine how incoming calls will be handled by the 
VPS. 8 different Service Groups can be configured; one Service Group can be assigned to each VPS 
port and PBX trunk (CO line), and each Service Group can be applied to more than one trunk (CO 
line) group or port as needed.

Follow the steps below to configure each Service Group:

[Parameters Edit]

1. Select the desired Service Group Number (1–8) in Service Groups table.

2. Edit each parameter in Group Parameters table.

[Assignment of Service Group]

1. Select a Service Group Number (1–8) in Assign Group To.

To assign to a single port or a range of ports

1. Click Port.

2. Check Single Port or Range of Ports.

3. Specify the desired port number or a range of port numbers (From:/To:).

To assign to a single trunk (CO line) or a range of trunks (CO lines)

1. Click Trunk.

2. Check Single Trunk or Range of Trunks.

3. Specify the desired trunk number or a range of trunk numbers (From:/To:).

2. Click Assign.

[Default Port/Trunk assignment]

Port 1-24 (KX-TVA200), 1-6 (KX-TVA50): Service Group No. 1

Trunk 1-64: None
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2.3 Port/Trunk Service
Service Mode
Assigns one of 6 Service Modes to the Service Group.

Note

• Once the Service Mode has been changed, it is retained unless the System Manager or 
System Administrator changes it again, even after the power is turned off.

• PBX Control Mode is only available when the VPS is connected to a Panasonic KX-T series 
PBX using APT/DPT Integration. If PBX Control Mode is selected but cannot be used, the 
VPS will operate in Automatic Mode.

• In Automatic Mode, services have this order of priority: 
Automatic Log-in (Toll Saver) > Holiday Service > Caller ID Call Routing > DID Call Routing 
> Trunk Service > Port Service

• In Manual Modes (Day, Night, Lunch, or Break), services have this order of priority: 
Automatic Log-in (Toll Saver) > Caller ID Call Routing > DID Call Routing > Trunk Service > 
Port Service 
(Holiday Service is disregarded.)

Default
Automatic

Value Range
Automatic: The current Call Service used by the Service Group is determined by the settings made 
for the current time mode (day, night, lunch, break).

Manual Day: The Call Service programmed for day mode is used, regardless of the current time 
mode.

Manual Night: The Call Service programmed for night mode is used, regardless of the current time 
mode.

Manual Lunch: The Call Service programmed for lunch mode is used, regardless of the current time 
mode.

Manual Break: The Call Service programmed for break mode is used, regardless of the current time 
mode.

PBX Control: The current Call Service used by the Service Group is determined by the settings 
made for the current time mode (day, night, lunch, break). The VPS will change time modes according 
to when the PBX changes time modes (APT/DPT Integration only).

Feature Manual References
2.4.6 Service Mode

Call Service

Call Service For Day, Night, Lunch, and Break
A call service is a group of parameters that determine how calls are handled throughout the day. Each 
Service Group (therefore each port and trunk [CO line]) can have a different call service for each time 
mode (day, night, lunch, break). One of 4 incoming call services (Voice Mail, Automated Attendant, 
Interview, or Custom Service) can be assigned to each call service.
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2.3 Port/Trunk Service
Company Greeting No.
Specifies the company greeting to be heard by callers. The System Greeting is "Good Morning/
Afternoon/Evening. Welcome to the Voice Processing System". Each call service can have its own 
setting.

Default
None

Value Range
None, 1–32, System

Feature Manual References
2.2.13 Company Greeting

Incoming Call Service
Specifies the incoming call service used to handle calls.

Note

• When you select Interview Service, an Interview Mailbox number should also be specified.

• When you select Custom Service, a Custom Service number should also be specified.

• The System Manager can change the "Incoming Call Service" after logging in to his or her 
mailbox (see 6.6 Changing the Company Greeting and Incoming Call Service Setting in 
Subscriber's Manual).

Default
Auto. Atten.

Value Range
Voice Mail, Auto. Atten., Interview, Custom

Feature Manual References
2.2.6 Call Services

2.2.39 Port Service

2.2.46 Trunk Service (Universal Port) (APT/DPT Integration Only)

Subscriber's Manual References
6.6 Changing the Company Greeting and Incoming Call Service Setting

Incoming Call Service Prompt
Specifies the language of system prompts used by this call service. If set to "Primary", the default 
language which is selected from all installed languages will be used. When set to "Selective", the 
caller can select the language of his or her choice, provided the System Administrator or the Message 
Manager has recorded the Multilingual Selection Menu. To specify Prompt Selection Number, see 
"Prompt Setting" in 2.5.4 Parameters. 
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2.3 Port/Trunk Service
Note

• If "Selective" is specified, you will need to select a prompt available for rotary callers. See 
"Prompt for Rotary Callers" below.

Default
Primary

Value Range
Primary, Selective, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: 1-10)

Programming Manual References
"Prompt Setting" in 2.5 System Parameters

Feature Manual References
2.2.44 System Prompts

Prompt for Rotary Callers
Specifies which language a rotary caller or an External Delivery Message receiver hears when he or 
she cannot enter any digits (Prompt Selection Number) after the Multilingual Selection Menu has 
been played. If set to "Primary", the default language which is selected from all installed languages 
will be used.

Note

• "Prompt for Rotary Callers" is only available when "Incoming Call Service Prompt" is set to 
"Selective".

Default
Primary

Value Range
Primary, Selective, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Feature Manual References
2.2.44 System Prompts

Delayed Answer Time
Specifies whether the port or trunk (CO line) answers immediately (0) or with delay (1 s – 60 s).

Default
0 s

Value Range
0 s–60 s
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2.3 Port/Trunk Service
Time Frame
Specifies the start and end times for each time mode for each day of the week. Each day of the week 
can have 1 lunch mode, up to 2 night modes (1 at the beginning and end of the day) and up to 3 break 
modes. Lunch and break modes cannot be inserted into a night mode. 
Follow the steps below to edit Time Frame:

1. Click Click to Edit….

2. Select a time mode, then enter the start and end times in the "Start At:" and "End At:" fields or 
drag the edges of the time mode to mark the start and end times.

To copy the time mode schedule of one day to another day

1. Select a time mode in the desired "copy from" day, and click Copy.

2. Select a time mode in the desired "copy to" day, then click Paste.

To insert a break or lunch mode

1. Right-click the desired time mode.

2. Select "Insert Break" or "Insert Lunch".

3. Click OK.

Note

• This setting is only available when "Automatic" is selected in "Service Mode".

Default
Day: 09:00-17:00, Lunch/Break: None

Value Range
00:00–23:59

Feature Manual References
2.2.45 Time Service

Caller ID/DID Call Routing
Enables or disables the Caller ID/DID Call Routing feature.

Default
Enable

Value Range
Disable, Enable

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)

2.2.19 DID Call Routing (DPT Integration Only)
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2.4 Service Settings
2.4 Service Settings
Service settings are divided into the following screens:

– Caller ID/DID/PIN Call Routing

– Holiday Settings

– Parameters

– Custom Service

Click each tab at the bottom of Service Settings screen to edit the parameters.

 
There are 2 methods to edit the parameters for "Caller ID/DID/PIN Call Routing" and "Holiday 
Settings":

a) Double-click a cell in the table of the screen, and edit the selected parameter.

b) Click the desired Caller ID/DID/PIN number or Holiday Service number, then, click Edit… and 
edit each parameter in the Edit Parameters dialog box.

Each parameter setting can be sorted in either ascending or descending order by clicking the header 
in "Caller ID/DID/PIN Call Routing" table and "Holiday Settings" table.
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2.4 Service Settings
2.4.1 Caller ID/DID/PIN Call Routing

A maximum of 200 Caller ID/DID/PIN numbers can be assigned so that callers are automatically 
forwarded to a preprogrammed destination. A different destination can be set for each time mode 
(day, night, lunch, break). PIN Call Routing is only available when the "Call Transfer Anytime" of a 
Custom Service is set to "PIN".

 
The service with the highest priority will handle the call. The order of priority is:

Holiday Service > Caller ID Call Routing > DID Call Routing > Trunk Service > Port Service.

 
Follow the steps below to edit Caller ID/DID/PIN Call Routing screen:

1. Select the desired mode (Caller-ID Mode, DID Mode, PIN Mode) in Mode:.

[Addition]

1. Click Add….

2. Edit parameters in the Edit Parameters dialog box.

3. Click OK.

[Deletion]

1. Select the desired Caller ID/DID/PIN number.

2. Click Delete.

3. Click Yes.

[Edit]

1. Select the desired Caller ID/DID/PIN number.

2. Click Edit….

3. Edit parameters in the Edit Parameters dialog box.

4. Click OK.

Note

• DID setting is only available when the VPS is connected to one of the following PBXs using 
DPT Integration.
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2.4 Service Settings
– KX-TD816 (P311Q or higher)

– KX-TD1232 (P211Q or higher)

– KX-TD500 (V4M or higher)

– KX-TDA series* (MPR Version 1.1 or higher) 
* except KX-TDA50

Caller ID/DID/PIN Number

Caller ID/DID/PIN Number
Specifies Caller ID/DID/PIN numbers so that callers are automatically forwarded to a preprogrammed 
destination. For Caller ID/DID numbers, " " substitutes for any number ( = wild card). For example, 
to route all calls from Area Code 201, enter "201  ". Also, "Private" or "Out of Area" callers 
can be specified by entering "P" for "Private" and "O" for "Out of Area" callers.

Default
None

Value Range

Max. 20 digits consisting of 0–9,  (P and O for Caller ID number only)

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)

2.2.19 DID Call Routing (DPT Integration Only)

2.2.37 PIN Call Routing

Description
Specifies a name and/or description of the Caller ID/DID/PIN number.

Note

• When no data is specified in this parameter, the caller's name will be automatically entered 
here if the caller's name is received from the telephone company.

Default
None

Value Range
Max. 20 characters

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)

2.2.19 DID Call Routing (DPT Integration Only)

2.2.37 PIN Call Routing
96 Programming Manual



2.4 Service Settings
Call Transfer for Day, Night, Lunch, and Break service
Specifies the destination to which the call from an assigned Caller ID/DID/PIN number is 
automatically forwarded. A destination can be set for each time mode. To disable the setting, select 
"None". A Mailbox Group number can be entered here instead of a mailbox number.

Default
None

Value Range
None: disables this feature.

Custom: forwards callers to the specified Custom Service menu.

Extn: forwards callers to the specified extension.

Mbx: forwards callers to the specified mailbox.

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)

2.2.19 DID Call Routing (DPT Integration Only)

2.2.37 PIN Call Routing
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2.4 Service Settings
2.4.2 Holiday Settings

You can program a maximum of 20 Holiday Services. On days specified as holidays, the holiday 
settings have priority over Service Group settings and Caller ID/DID/PIN Call Routing.

 
The service with the highest priority will handle the call. The order of priority is:

Holiday Service > Caller ID Call Routing > DID Call Routing > Trunk Service > Port Service

 
Follow the steps below to edit Holiday Settings screen:

[Addition]

1. Click Add….

2. Edit parameters in the Edit Parameters dialog box.

3. Click OK.

 [Deletion]

1. Select the desired Holiday Service number.

2. Click Delete.

3. Click Yes.

 [Edit]

1. Select the desired Holiday Service number.

2. Click Edit….
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2.4 Service Settings
3. Edit parameters in the Edit Parameters dialog box.

4. Click OK.

Note

• Holidays cannot overlap. For example, if you have set Dec. 22nd to Jan. 6th as a holiday, 
you cannot set Jan. 1st as a holiday. 

• To provide a special message to callers on a holiday (for example, "Today is New Year's Day 
and our office is closed. If you wish to record a message, please press 1 now".), you can 
create a Custom Service menu. Use this setting to direct calls to this Custom Service on 
Jan. 1st. Use foreign languages where appropriate.

Holiday Service No.

Name of Holiday
Specify a name or description for the holiday.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.24 Holiday Service
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2.4 Service Settings
Start Date
Specifies the start date of the holiday.

Default
None

Value Range
MM/DD (MM: Month, DD: Day)

Feature Manual References
2.2.24 Holiday Service

Start Time
Specifies the start time of the holiday.

Default
None

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.24 Holiday Service

End Date
Specifies the end date of the holiday.

Note

• When the start date and time are specified and the end date and time are "Not Set", the 
Holiday will be automatically ended at "00:00".

Default
None

Value Range
MM/DD (MM: Month, DD: Day)

Feature Manual References
2.2.24 Holiday Service

End Time
Specifies the end time of the holiday.

Note

• When the start date and time are specified and the end date and time are "Not Set", the 
Holiday will be automatically ended at "00:00".
100 Programming Manual



2.4 Service Settings
Default
None

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.24 Holiday Service

Retain Holiday
Stores the Holiday Service setting for future use. If set to "Yes", the same setting will function 
automatically on the same day every year. If set to "No", the setting will be canceled automatically 
after the holiday is over.

Default
No

Value Range
Yes, No

Feature Manual References
2.2.24 Holiday Service

Company Greeting No.
Specifies the Company Greeting to be played on the holiday. The System Greeting is: "Good Morning/
Afternoon/Evening. Welcome to the Voice Processing System." (However, the System Administrator 
and the Message Manager can change this.)

Default
None

Value Range
None, 1–32, System

Feature Manual References
2.2.13 Company Greeting

2.2.24 Holiday Service

Service
Specifies which incoming call service handles calls on the holiday.

Note

• When Interview Service is selected, a subscriber's Interview Mailbox number should also be 
specified. When Custom Service is selected, a Custom Service number (1-100) should also 
be specified.
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2.4 Service Settings
Default
Auto. Atten.

Value Range
Voice Mail, Auto. Atten. Interview, Custom

Feature Manual References
2.2.6 Call Services

2.2.24 Holiday Service

Port Affected
Specifies the port numbers for which the Holiday Service setting is activated. Ports not specified here 
are handled by the incoming call service assigned to those ports in the PORT/TRUNK Service 
screen. The maximum number of ports depends on the VPS model.

Default
1-24 (KX-TVA200)

1-6 (KX-TVA50)

Value Range
1–24 (KX-TVA200)

1–6 (KX-TVA50)

Feature Manual References
2.2.24 Holiday Service

Trunk Affected
Specifies the trunks (CO lines) for which the Holiday Service setting is activated. Trunks (CO lines) 
not specified here are handled by the incoming call service assigned to those trunks (CO lines) in the 
PORT/TRUNK Service screen.

Default
1-64

Value Range
1–64

Feature Manual References
2.2.24 Holiday Service
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2.4 Service Settings
2.4.3 Parameters

The following parameters can be specified in Parameters screen.

– Automated Attendant

– Rotary Telephone Service

– Name Entry

– Toll Saver

Automated Attendant
Specifies the parameters of functions for Automated Attendant Service.

Wait Time for First Digit
Specifies the length of time the VPS waits for the caller to dial a digit before assuming the caller is 
using a rotary telephone and therefore activates Rotary Telephone Service.

Default
6 s
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2.4 Service Settings
Value Range
0 s–20 s

Feature Manual References
2.2.3 Automated Attendant

Menu Repeat Cycle
Specifies the number of times the VPS will play the Automated Attendant top menu if the caller does 
not make a selection.

Default
3 times

Value Range
1–5 times

Play Owner's Name during Transfer
Determines whether "Transferring you to <name>." is announced to the caller before transferring the 
caller to an extension.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.3 Automated Attendant

Operator Service
These parameters specify the extension numbers and mailbox numbers for operators 1, 2, and 3, as 
well as calls are treated when they are directed to and operator. Operator parameters can be set 
individually for day, night, lunch, and break modes.

Note

• All non-touch input calls in Automated Attendant Service will be transferred to the General 
Delivery Mailbox when the Operator Service is disabled.

Operator Service For Day, Night, Lunch, and Break
Determines the settings for each operator in each time mode. Note that the extension assigned as 
Operator 1 for day mode is automatically designated as the Message Manager. When operator calls 
are made, calls are connected to the lowest-numbered operator that is available. To enable/disable 
the operator setting for each time mode, check/uncheck it.

Note

• Because the extension number assigned for Operator Service No. 1 in the Day Mode is for 
the Message Manager, you cannot assign this extension to any other mailbox.
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2.4 Service Settings
• Extensions assigned as operators can be called by dialing [0], however, when setting 
features such as Message Waiting Notification and Remote Call Forwarding, the extension 
number (not "0") must be specified.

Default
Enable (checked)

Value Range
Disable (unchecked), Enable (checked)

Feature Manual References
2.2.36 Operator Service

Operator Service No. 1, 2, and 3

Operator's Extension
Specifies the extension number for Operator 1, 2, and 3.

Note

• The default extension number of Operator 1 in day mode cannot be used with the Message 
Waiting Notification Lamp feature.

• Because the extension number assigned as Day Mode Operator 1 is automatically 
designated as the Message Manager, do not assign this extension number to a mailbox. 
This extension number is automatically assigned to mailbox number 998.

Default
0 for Operator 1, None for Operator 2, and Operator 3

Value Range
1–5 digits

Feature Manual References
2.2.36 Operator Service

Operator's Mailbox No.
Specifies the mailbox number for Operator 1, 2, and 3. Callers to Operator 1, 2, or 3 are prompted to 
leave a message in this mailbox depending upon how the Busy Coverage or No Answer Coverage 
modes are set.

Default
998 for Operator 1, None for Operator 2, and Operator 3

Value Range
2–5 digits

Feature Manual References
2.2.36 Operator Service
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Busy Coverage Mode
Specifies how to handle calls when the operator is busy.

Default
Hold

Value Range
Hold: Automatically places the caller on hold and the operator is called again.

No Answer Coverage: Offers the option specified by the No Answer Coverage Mode to the caller.

Call Waiting: Signals the operator when another call is waiting using the Call Waiting feature of PBX.

Disconnect Message: Disconnects the caller after playing "Thank you for calling".

Feature Manual References
2.2.5 Busy Coverage Mode

No Answer Coverage Mode
Specifies how to handle operator calls when they are not answered within the time period set in 
"Operator No Answer Time".

Default
Caller Select

Value Range
Caller Select: Allows the caller to leave a message or call another extension. In the following cases, 
the caller cannot call another extension.

a) No input to Automated Attendant.

b) No input to Custom Service menu when "No DTMF Input Operation" is set to "Operator" in 
"Service Settings→ Custom Service→ Menu & Transfer".

Leave Message: Instructs the caller to leave a message in the operator's mailbox.

Disconnect Message: Disconnects the caller after playing "Thank you for calling".

Next Operator: Transfers the caller to the next operator.

Feature Manual References
2.2.34 No Answer Coverage Mode

Operator No Answer Time
When a call to an operator is not answered within the time set, the VPS will offer other options as 
defined by the "No Answer Coverage Mode".

Note

• This time applies to Operator 1, 2, and 3

• If more than one operator is assigned, we recommend to reducing the "Operator No Answer 
Time" to 15 s.

Default
30 s
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2.4 Service Settings
Value Range
10 s–60 s

Feature Manual References
2.2.34 No Answer Coverage Mode

Call Hold Mode

Call Hold Mode
If set to "Enable", the VPS gives callers the option of either holding for a specific extension or selecting 
one of several Incomplete Call Handling Service options. While on hold, the VPS periodically gives 
callers the choice to either continue to hold or select one of the Incomplete Call Handling Service 
options. If set to "Disable", the VPS immediately offers callers the Incomplete Call Handling Service 
and callers are not put on hold. To enable/disable this feature, check/uncheck it.

Default
Enable (checked)

Value Range
Disable (unchecked), Enable (checked)

Feature Manual References
2.2.23 Hold

Call Queuing Announcement Mode
If set to "Enable", callers on hold are informed of their current position in the call hold queue.

 
Example: "One other person is waiting to connect."

Default
Enable

Value Range
Disable, Enable

Feature Manual References
2.2.23 Hold

Call Retrieval Announcement Timing
Specifies the interval between the voice guidance message that asks whether or not calls are to be 
retrieved during call holding.

 
Example: "To cancel holding, press 2 now. Otherwise, I'll try your party again."
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Default
2 s

Value Range
1s–30 s

Feature Manual References
2.2.23 Hold

Redial Cancel Timing
Specifies the interval between the voice guidance messages that ask if continuous redials are to be 
attempted during call holding.

 
Example: "To continue holding, press 1. Otherwise, press 2."

Default
30 s

Value Range
15 s, 30 s, 45 s, 60 s

Feature Manual References
2.2.23 Hold

Hold Recall Mode
Specifies how the VPS handles a call when the call transfer sequence is Call Transfer without 
Announcement and the transferred call is not answered.

Default
Return to Top Menu

Value Range
Return to Top Menu, Message Recording

Feature Manual References
2.2.23 Hold

Alternate Extension
Specifies an extension, which requires a different transfer sequence than normal. Calls to these 
extensions will be transferred according with the setting in "Alternate Extension Transfer Sequence" 
in 2.5.4 Parameters. Follow the steps below to edit Alternate Extension:

1. Click Click to edit….

[Addition]

1. Click the icon [New].

2. Enter an extension number.
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3. Click OK.

[Edit]

1. Select the desired alternate extension.

2. Click the icon [Edit].

3. Edit the extension number.

4. Click OK.

[Deletion]

1. Select the desired alternate extension.

2. Click the icon [Delete].

3. Click Yes.

Note

• The Extension Group List or Logical Extension Numbers cannot be assigned.

Default
None

Value Range
Max. 32 extensions (max. 5 digits per extension)

Feature Manual References
2.2.1 Alternate Extension Group

List All Names
If set to "Enable", callers can listen to all subscribers' name and extension number in Automated 
Attendant Service or Custom Service.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.27 List All Names

Rotary Telephone Service
Determines how calls are handled when callers do not dial any numbers in response to VPS guidance 
(often because they are rotary telephone users).

Rotary Telephone Service Call Coverage for Day, Night, Lunch, and Break 
service

Determines how calls are handled when callers do not dial any numbers in response to VPS guidance 
(often because they are rotary telephone users). Callers can be transferred to a preprogrammed 
extension or mailbox, including an operator or the General Delivery Mailbox.
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Default
G.D.M

Value Range
G.D.M: The caller is transferred to the General Delivery Mailbox.

Operator: The caller is transferred to an operator.

Mbx: The caller is transferred to the mailbox specified here.

Extn: The caller is transferred to the extension specified here.

Feature Manual References
2.2.40 Rotary Telephone Service

Name Entry
Specifies the parameters relating to the Dial by Name feature, which allows to connect themselves 
with the desired party by entering the first 3 or 4 letters of the party's name.

Number of Digits to Entry Name
Specifies the number of digits (letters) that must be entered when using the Dial by Name feature.

Default
4

Value Range
3–4 digits

Feature Manual References
2.2.18 Dialing by Name

Name Entry Time Out
Specifies the length of time that the VPS waits for the caller to enter the first 3 digits (letters) of the 
desired party's name. If the required number of digits are not dialed within this time, the previous 
menu will be played again for the caller.

Default
6 s

Value Range
1 s–10 s

Feature Manual References
2.2.18 Dialing by Name

Key Mode
Specifies the standard used for keypad text entry. If set to use the North American Standard, press 
[7] for "Q" and [9] for "Z", If set to use the Australasian Standard, press [1] for "Q" and "Z".
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Default
North American Standard

Value Range
North American Standard, Australasian Standard

Feature Manual References
2.2.18 Dialing by Name

Name Directory Mode
Specifies one of Last Name, First Name, or Both to be used when entering the name.

Default
Last

Value Range
Last, First, Both

Toll Saver

Delayed Answer Time for New Message
Specifies the time period before the VPS answers the call when there are new messages.

Default
12

Value Range
5 s–60 s

Programming Manual References
2.1.10 Automatic Log-in

Feature Manual References
2.3.31 Toll Saver (APT/DPT Integration Only)

Delayed Answer Time for No New Messages
Specifies the time period before the VPS answers the call when there is no new messages.

Default
24

Value Range
5 s–60 s
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Programming Manual References
2.1.10 Automatic Log-in

Feature Manual References
2.3.31 Toll Saver (APT/DPT Integration Only)
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2.4.4 Custom Service

Allows callers to perform specific functions by pressing dial buttons on their telephones while listening 
to voice guidance (Custom Service Menu). Custom Services allow callers to connect themselves to 
an extension, mailbox, Mailbox Group, operator, fax machine, etc., without the assistance of an 
operator. Custom Service Menu ("Press 1 for Sales, press 2 for Service...", etc.) can be recorded by 
the System Administrator or the Message Manager, and can be recorded in several languages if 
needed. The System Administrator can create a maximum of 100 Custom Services. 

Common uses for Custom Services include:

– callers press a button to connect themselves with the desired destination

– callers press buttons to navigate through a series of other Custom Services before being 
connected with the desired destination

– callers enter PIN numbers to connect themselves with the desired destination (PIN Call 
Routing)

– callers enter the first few letters of the desired parties (Dial by Name) to connect themselves 
with the desired destination

Custom Service Builder

Custom Service DiagramCustom Service List

Custom Service Type
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The Custom Service Builder is a utility that allows the System Administrator to create Custom 
Services visually. Each Custom Service and its functions can be edited, arranged using a familiar 
drag-and-drop interface. 

There are following types of Custom Services:

– Menu & Transfer

– Date Control

– Time Control

– Day Control

– Password

[Creation]

1. Click the desired Custom Service type under Custom Service Type:.

2. Drop the Custom Service icon, then the setting screen for the Custom Service will open.

3. Edit parameters in the CS No. dialog box.

4. Click OK.

Drag & Drop

Edit and Press "OK"

Custom Service 
is completed
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[Edit]

Custom Services parameters can be connected to other Custom Services. To connect a parameter 
to another Custom Service, click and hold the parameter's blue handle, drag it to the desired Custom 
Service, then release the mouse button.

You can edit each Custom Service in the following way.

[From Custom Service List]

1. Enter the desired Custom Service number under 
Quick Search:, and click Edit Custom, or double-
click the desired Custom Service icon.

2. Edit parameters in the CS No. dialog box.

3. Click OK.

[From Custom Service Diagram]

1. Right-click on the desired Custom Service icon in 
the diagram.

2. Choose Edit....

3. Edit parameters in the CS NO. dialog box.

4. Click OK.
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[Example: Setting "Menu & Transfer"]

1. Click Menu & Transfer out of Custom Service Type and drag it to the right of the screen. 

The cursor will be changed into .

2. Drop Menu & Transfer on where it should be in the Custom Service diagram. 
When you drop, the setting screen for the Menu & Transfer will open.
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3. Enter or select a value for each item. 
For each parameters, refer to the description in the following section.

4. Click "Record A Prompt For This Custom Service...". 
This feature is only available when setting "Menu & Transfer" or "Password". You can also 
skip this step, and go to Step 6.

5. Select "Record from extension" or "Import from recorded file".

When "Record from extension" is selected

1. Specify the extension number of the telephone used for recording, then click 
Connect.
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2. When the specified extension rings, go off-hook.

3. Click  (record),  (stop), or  (play) to record or 
play a voice label through the extension.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click …. 
The Open dialog box appears.

2. Navigate to the folder containing the WAV files you want to open. 
(WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 
4 bit, mono.)

3. Select the desired WAV file.

4. Click Open to import the file.

Note

• The Message Manager can also use his or her telephone to record a prompt for 
this Custom Service (see 7.6 Recording Messages in Subscriber's Manual).

6. Click OK.

Feature Manual References
2.4.2 Custom Service Builder

Menu & Transfer
This Custom Service type guides callers to press certain buttons to connect themselves with the 
designated party. The prompt for this service can be recorded in the CS No. dialog box.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Prompt Mode
Specifies the language for prompts used by this Custom Service.
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Note

• This parameter overrides "Incoming Call Service Prompt".

• If "Primary" is selected, the default language which is selected from all installed languages 
will be used.

• If "None" is selected, the prompt mode of previous process will be continued, or "Primary" 
language will be selected.

Default
Primary

Value Range
None, Primary, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Programming Manual References
"Incoming Call Service Prompt" in 2.3.1 Service Group

Feature Manual References
2.2.16 Custom Service

Menu Repeat Cycle
Specifies the number of times the Custom Service menu message will be repeated for the caller.

Default
1

Value Range
1–3 times

Feature Manual References
2.2.16 Custom Service

Call Transfer Anytime
Specifies the type of dialing that the VPS accepts during the Custom Service in addition to the single-
digit Custom Service options. This setting allows callers to dial numbers to connect themselves to an 
extension or mailbox or enter a PIN.

Note

• If you only need to allow callers to dial single-digit Custom Service option numbers, set this 
parameter to "No". When set to a value other than "No", the VPS always waits for the amount 
determined by the "Wait for Second Digit" setting before handling the call. This will cause a 
delay between the time the caller dials a single-digit Custom Service option number and 
when the call is actually handled.

Default
Extn
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Value Range
Extn: enables callers to be transferred directly to their intended party by dialing the extension number. 
Mbx: enables callers to leave messages in a mailbox by entering the mailbox number. 
PIN: enables callers to be transferred directly to the specified party according to the setting for PIN 
Call Routing Service by dialing PIN.  
No: disables extension transfer and mailbox transfer; only 1-digit entries will function (following the 
Custom Service menu)

Feature Manual References
2.2.16 Custom Service

Wait for First Digit
Specifies the length of time that the VPS waits for the caller to dial the first digit after a Custom Service 
menu is played for the caller. If this time expires, the No DTMF Operation settings determines how 
the call is then handled. If this parameter is set to "0", No DTMF Input Operation handles the call 
immediately after the menu is played for the caller.

Default
6 s

Value Range
0 s–10 s

Feature Manual References
2.2.16 Custom Service

Wait for Second Digit
This parameter is only valid when "Call Transfer Anytime" is set to a value other than "No". After the 
caller dials a digit (the first digit) after listening to a Custom Service menu, the VPS waits for a second 
digit to be dialed. This gives the caller time to continue dialing a mailbox number, extension number, 
or PIN. If this time expires without a second digit being entered, the VPS assumes the caller has 
selected a Custom Service menu option and handles the call according to the digit dialed by the 
caller.

Default
1 s

Value Range
1 s–5 s

Feature Manual References
2.2.16 Custom Service

No DTMF Input Operation
Determines how calls are handled when callers do not dial any numbers after listening to the menu 
message (most likely because they are using rotary telephones) The default setting is "Operator", 
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which allows the caller to be automatically connected to an operator after the menu message plays 
back ("...or stay on the line to be connected to an operator.").

Default
Operator

Value Range
Trf to Mbx: Allows the caller to leave messages in a specified mailbox.

Trf to Extn: Transfers the caller to a specified extension.

Operator: Connects the caller to an operator.

Trf to Out: Transfers the caller to a specified outside telephone number. Enter the Trunk (CO Line) 
Access number of the PBX then the destination telephone number.

Exit: Plays the Custom Service exit prompt and disconnects the caller. 

Prev Menu: Returns the caller to the previous menu (if there was a previous menu).

Cust Serv : Transfers the caller to the Custom Service specified here.

Feature Manual References
2.2.16 Custom Service

Keypad Assignment 0–9, *, #
Any of the 16 operations listed below can be assigned to the 0 through 9, , and # keys on the 
telephone keypad. Callers are able to access these operations by pressing the corresponding keys 
on their telephones.

Default

: Exit

0: Operator

Others: None

Value Range
Trf to Mbx: Allows the caller to leave messages in a specified mailbox.

Trf to Extn: Transfers the caller to a specified extension.

Operator: Connects the caller to an operator.

Trf to Out: Transfers the caller to a specified outside telephone number. Enter the Trunk (CO Line) 
Access number of the PBX then the destination telephone number.

Exit: Plays the Custom Service exit prompt and disconnects the caller.

Prev Menu: Returns the caller to the previous menu (not available if there was no previous menu).

Cust Serv: Transfers the caller to the Custom Service specified here.

VM Serv: Allows the caller to access Voice Mail Service.

Call Trf Serv: Allows the caller to access Automated Attendant Service.

Subscr Serv: Allows the caller to access Subscriber Service. If this option is enabled, it is strongly 
recommended that each subscriber establish a password; this will prevent unauthorized callers from 
accidentally or intentionally accessing subscribers' mailboxes.

Dial by Name: Requests the caller to enter the first 3 or 4 letters of a first or last name of the person 
the caller wishes to reach, then transfers the caller to the corresponding extension.

Repeat Menu: Repeats the Custom Service menu.
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Main Menu: Returns the caller to the Custom Service top menu.

Fax Trf: Allows the caller to send fax messages to an extension specified as the fax extension.

List All Names: The VPS will announce the names and extensions numbers of all subscribers 
(except those whose Class of Service "Directory Listing" parameter is set to "No").

None: No operation assigned.

[e.g. assigning "Key 1" to "Transfer to Extension 101"]

1. Click the check box for "Key 1".

2. Select "Trf to Ext" in the "Assigned Operation" column.

3. Enter "101" in the "Value" column.

[e.g. canceling the setting for "Key 1"

1. Clear the check box for "Key 1".

Feature Manual References
2.2.16 Custom Service

Date Control
This service allows you to assign a different operation for up to 5 time periods. The caller makes no 
selection and no menu is announced.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Date Period 1–5, Outside
<Period 1–5>

Specifies the name of date period for reference, start and end date, and an operation.

<Outside>

Allows you to specify an operation that is enabled on all other dates not included in the set periods.
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Default
None

Value Range
<Period 1–5>

Name: Max. 16 characters 
Date: MM/DD (MM: Month, DD: Day)

Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

<Outside>

Name: Max. 16 characters

Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

Feature Manual References
2.2.16 Custom Service

Time Control
This service allows you to assign a different operation for up to 5 blocks of time during the day. The 
caller makes no selection and no menu is announced.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Time Period 1–5, Outside
<Period 1–5>

Specifies the name of time period for reference, start and end time, and an operation.

Note

• When the start time is specified and the end time is "Not Set", the period will be automatically 
ended at "00:00".

• If several time periods overlap each other, the time period beginning with the lowest number 
has a priority: the operation assigned to the lowest numbered time period is activated for the 
overlapped time period.

<Outside>
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Allows you to specify an operation that is enabled for all other times not included in the set time 
periods.

Default
None

Value Range
<Period 1–5>

Name: Max. 16 characters 
Time: HH:MM (HH: Hour, MM: Minute) 
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

<Outside>

Name: Max. 16 characters

Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

Feature Manual References
2.2.16 Custom Service

Day Control
This service allows you to assign a different operation for each day of the week, and for all holidays. 
The caller makes no selection and no menu is announced.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Monday–Sunday, and Holiday
Specifies a service for each day of the week and for all holidays.

Note

• If an operation is assigned to "Holiday" here, either one of the following settings is required 
in order to activate the operation for "Holiday" Custom Service:

a. In "Service Settings"→ "Holiday Settings"→ the desired "Holiday Service"→ "Service", 
select "Custom" and specify the number of this Date Control-"Holiday" Custom Service, or 
the number of its higher layered Custom Service.
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b. Assign the desired Date Control-"Holiday" Custom Service or its higher layered Custom 
Service to the desired Port/Trunk (see 2.3.1 Service Group). 
In "Service Settings"→ "Holiday Settings"→ the desired "Holiday Service"→ "Port/Trunk 
Affected", exclude the Port/Trunk numbers that are assigned to the Date Control-"Holiday" 
Custom Service or the number of its higher layered Custom Service.

Default
None

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr 
Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad 
Assignment 0–9, *, #")

Feature Manual References
2.2.16 Custom Service

Password
This service requires that callers enter a password. Each password is assigned an operation. If a 
password is entered correctly, the caller is handled by the password's preprogrammed operation. The 
prompt for this service can be recorded in the CS No. dialog box.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Menu Repeat Cycle
Specifies the number of times the Custom Service menu message will be repeated to the caller.

Default
3

Value Range
1–3 times

Feature Manual References
2.2.16 Custom Service
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Wait for First Digit
Specifies the length of time that the VPS waits for the caller to dial the first digit after a Custom Service 
menu is played for the caller. If this time expires, the No DTMF Operation setting determines how the 
call is then handled. If this parameter is set to "0", No DTMF Input Operation handles the call 
immediately after the menu is played for the caller. 

Default
6 s

Value Range
0 s–10 s

Feature Manual References
2.2.16 Custom Service

Maximum Number of Invalid Entry
Specifies the times an invalid password is entered before following "Entry Failure" setting.

Default
3

Value Range
1–10 times

Feature Manual References
2.2.16 Custom Service

No DTMF Input Operation
Determines how calls are handled when callers do not dial any numbers in response to VPS guidance 
(often because they are rotary telephone users). The default setting is "Operator", which allows the 
caller to be automatically connected to an operator after the message is played.

Default
Operator

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv (see "No DTMF Input 
Operation" in "Menu & Transfer")

Feature Manual References
2.2.16 Custom Service

Entry Failure
Determines what operation is activated when a caller enters an invalid password X times. (X= the 
value set for "Maximum Number of Invalid Entry")
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Default
Exit

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr 
Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names (see "Keypad Assignment 0–
9, *, #")

Feature Manual References
2.2.16 Custom Service

Password 1–5, Cancel
<Password 1–5>

Specifies a password and an operation for the specified password.

<Cancel>

Determines the operation that is activated when a caller presses "#" to cancel password entry.

Default
None

Value Range
<Password 1–5>

Password: Max. 12 digits  
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

<Cancel>

Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Tr 
Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see 
"Keypad Assignment 0–9, *, #")

Feature Manual References
2.2.16 Custom Service
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2.5 System Parameters
System Parameters are divided into the following screens:

– Mailbox Group

– Extension Group

– System Caller Name Announcement

– Parameters

Click each tab at the bottom of System Parameters screen to edit the parameters.

Each parameter setting can be sorted in either ascending or descending by clicking the header 
except in "Parameters" table.

2.5.1 Mailbox Group

Mailbox Groups allow a caller or subscriber to leave a message that is placed in the mailbox of each 
subscriber in the list. The message is recorded once and sent to all subscribers. This parameters 
allows a caller to send a message at the same time to several mailboxes. The VPS can maintain a 
maximum of 20 Mailbox Groups. Each group can have a maximum of 62 members for KX-TVA50 or 
100 members for KX-TVA200. Only the System Administrator can create or edit Mailbox Groups. 
(Each subscriber can create and edit his or her own Personal Group Distribution Lists.)

Follow the steps below to edit Mailbox Group screen:

[Addition of Group List No.]

1. Click Add….
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2. Enter a group list number and a group name.

3. Click OK.

[Deletion of Group List No.]

1. Select the desired group list number.

2. Click Delete.

3. Click Yes.

[Edit of Group List No.]

1. Select the desired group list number.

2. Click Edit….

3. Edit parameters in the Edit Mailbox Group dialog box.

4. Click OK.

[Recording of Group List Name in the Edit Mailbox Group dialog box]

1. Select "Record from extension" or "Import from recorded file".

When "Record from extension" is selected

1. Specify the extension number of the telephone used for recording, then click Connect.

2. When the specified extension rings, go off-hook.

3. Click  (record),  (stop), or  (play) to record or play a 
voice label through the extension.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click …. 
The Open dialog box appears.

2. Navigate to the folder containing the WAV files you want to open. 
(WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, 
mono.)

3. Select the desired WAV file.

4. Click Open to import the file.

[Add Subscribers to Group List]

1. Select the desired group list number.

2. Click Add….

3. Enter a mailbox number in Quick Search Mailbox: or select the mailbox number in Subscribers 
to add table.
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4. Click Add >>.

5. Click OK.

[Delete Subscribers from Group List]

1. Select the desired mailbox number.

2. Click Delete.

3. Click Yes.

[Search for Subscriber]

1. Click Search Subscribers….

2. Enter the Mailbox No., Extension No., First Name, or Last Name of the desired subscriber.

3. Click OK.

Group List No.
Specifies the Group List number. This number is similar to a mailbox number and is used to send a 
message to all subscribers of the group. It must be a unique number; no other group or mailbox can 
be assigned this number.

Default
None

Value Range
2–5 digits

Feature Manual References
2.3.13 Group Distribution List—System
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Group Name
Specifies the group name.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.3.13 Group Distribution List—System
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2.5.2 Extension Group

An Extension Group is a group of extensions that share a common mailbox. Each group has an 
Extension Group number. If the group number is assigned as the owner of a mailbox, then all 
members cannot be assigned their own personal mailboxes. 
Up to 20 Extension Groups can be created, and each group can consist of 100 extensions 
(members). 
You can add, delete, and review the extensions. Members of an Extension Group are able to share 
the same mailbox and be notified by the Message Waiting Notification–Lamp feature when a 
message is received.

Follow the steps below to edit Extension Group screen:

[Addition of Group List No.]

1. Click Add….

2. Enter a group list number and a group name.

3. Click OK.

[Deletion of Group List No.]

1. Select the desired group list number.
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2. Click Delete.

3. Click Yes.

[Edit of Group List No.]

1. Select the desired group list number.

2. Click Edit….

3. Edit parameters in the Edit Extension Group dialog box.

4. Click OK.

[Recording of Group List Name in the Edit Extension Group dialog box]

1. Select "Record from extension" or "Import from recorded file".

When "Record from extension" is selected

1. Specify the extension number of the telephone used for recording, then click Connect.

2. When the specified extension rings, go off-hook.

3. Click  (record),  (stop), or  (play) to record or play a 
voice label through the extension.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click …. 
The Open dialog box appears.

2. Navigate to the folder containing the WAV files you want to open.  
(WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, 
mono.)

3. Select the desired WAV file.

4. Click Open to import the file.

[Add Extension to Group List]

1. Select the desired group list number.

2. Click Add….
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3. Enter an extension number in Extension Number:.

4. Click OK.

[Delete Extension from Group List]

1. Select the desired extension number.

2. Click Delete.

3. Click Yes.

Group List No.
Specifies any vacant extension number.

Note

• In order to configure an Extension Group, set a group number here, then assign the group 
number as the owner of a mailbox. The Extension Group List number is effectively the 
extension number that is the owner of the group's mailbox.
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Default
None

Value Range
2–5 digits

Feature Manual References
2.2.21 Extension Group

Group Name
Specify the group name.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.21 Extension Group
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2.5.3 System Caller Name Announcement

Allows the System Administrator to store a maximum of 200 telephone numbers and record a caller 
name for each telephone number. The caller name is announced when playing a message in their 
mailbox from one of the preprogrammed callers, when the VPS transfers a call to the subscriber from 
one of the preprogrammed callers (Caller ID Screening), and when the VPS pages the subscriber by 
intercom (Intercom Paging).  
Caller ID Screening feature is only available when "Yes" is set for "Caller ID Screen" in the Class of 
Service (COS) settings. This feature is also enabled by selecting "Call Screening" in 5.1 Call Transfer 
in the Subscriber's Manual. 
The Intercom Paging feature is enabled by selecting "Intercom Paging" in 5.1 Call Transfer, and/or in 
5.2 Incomplete Call Handling in the Subscriber's Manual.

 
Follow the steps below to edit System Caller Name Announcement screen:

[Addition of Caller-ID No.]

1. Click Add….

2. Enter a Caller ID number and description.
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3. Click OK.

[Deletion of Caller-ID No.]

1. Select the desired group list number.

2. Click Delete.

3. Click Yes.

[Edit of Caller-ID No.]

1. Select the desired Caller ID number.

2. Click Edit….

3. Edit parameters in the Call Information dialog box.

4. Click OK.

[Recording of Caller Name in the Caller Information dialog box]

1. Select "Record from extension" or "Import from recorded file".

When "Record from extension" is selected

1. Specify the extension number of the telephone used for recording, then click Connect.

2. When the specified extension rings, go off-hook.

3. Click  (record),  (stop), or  (play) to record or play a 
voice label through the extension.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click …. 
The Open dialog box appears.

2. Navigate to the folder containing the WAV files you want to open. 
(WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, 
mono.)

3. Select a file to import.

4. Click Open to import the file.

Caller ID No.
Assigns the telephone number for which the VPS announces the prerecorded caller name to 
extension users.

Default
None

Value Range
Max. 20 digits consisting of 0–9

Feature Manual References
2.2.11 Caller Name Announcement—System (APT/DPT Integration Only)

Description
Enters a name and/or description of the Caller ID number.
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Default
None

Value Range
Max. 20 characters

Feature Manual References
2.2.11 Caller Name Announcement—System (APT/DPT Integration Only)
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2.5.4 Parameters

The following settings can be made in the Parameter tab of the System Parameters screen:

– Time Setting

– Prompt Setting

– PBX Parameters

– Dialing Parameters

– Message Waiting Notification

– External Message Delivery

– Intercom Paging Parameters

– Fax Management

– Disconnect Parameters

– Transfer to Outside

– VM Menu

– E-mail Integration
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Time Setting
Adjusts the internal clock of the VPS.

System Clock

System Date/Time
Specifies the system date and time.

Default
None

Value Range
Date: YYYY/MM/DD (YYYY: Year, MM: Month, DD: Day) 
Time: HH:MM (HH: Hour, MM: Minute)
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Feature Manual References
2.2.43 System Clock

Format
Specifies the time format (12-hour or 24-hour).

Note

• The selected time format (12-hour or 24-hour) affects the time format of reports, the VM 
Menu feature, as well as the time that appears in e-mail notifications for new messages.

Default
12 H

Value Range
12 H, 24 H

PBX Synchronization
Specifies whether to synchronize the VPS clock with the clock of the PBX.

Note

• Time Synchronization is only available when the VPS is connected to a Panasonic KX-T 
series PBX using DPT Integration.

Default
Synchronize

Value Range
Synchronize, Not synchronize

Feature Manual References
2.4.10 Time Synchronization (DPT Integration Only)

Daily Hours Setting
Specifies the starting time of the morning, afternoon and evening greetings used for the Company 
Greeting.

Morning Hours Start Time
Specifies the starting time of the morning greeting.

Default
03:00

Value Range
HH:MM (HH: Hour, MM: Minute)
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Feature Manual References
2.2.13 Company Greeting

Afternoon Hours Start Time
Specifies the starting time of the afternoon greeting.

Default
12:00

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.13 Company Greeting

Evening Hours Start Time
Specifies the starting time of the evening greeting.

Default
18:00

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.13 Company Greeting

Daylight Saving Time
Specifies whether to use daylight saving time. If "Enter Time Frame" is selected, both the starting date 
and ending date must be set. The same date cannot be used for both settings. The clock adjusts itself 
from 2 am to 3 am on the starting date, and adjusts itself from 2 am to 1 am on the ending date.

WARNING

If the VPS clock is synchronized with the PBX clock (see "2.4.10 Time 
Synchronization (DPT Integration Only)" in the Feature Manual), the daylight 
saving time setting of the VPS is not used. Adjust the PBX for daylight saving time 
as necessary.

Note

• The VPS changes to and from DST at 2:00 AM. In most of the United States, DST begins 
at 2:00 AM on the first Sunday in April and ends at 2:00 AM on the last Sunday in October.

Default
None
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Value Range
None

Enter Time Frame (Start Date, End Date): MM/DD (MM: Month, DD: Day)

Feature Manual References
2.2.17 Daylight Saving Time Assignment

Prompt Setting
This setting is required when Multilingual Service is enabled.

Primary Language
Specifies the default language to be used when another language is not selected in the Multilingual 
Selection Menu.
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Default
English (US)

Value Range
Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Feature Manual References
2.2.33 Multilingual Service

2.2.44 System Prompts

Language 1–5 (KX-TVA200), 1–3 (KX-TVA50)
Assign a selection number (1–9) to each language. Callers use the numbers to select the desired 
languages for their message prompts. This setting is required when either one or both of the following 
parameters are set to "Selective":

a) "Prompt Mode" in 2.1.5 External Message Delivery

b) "Incoming Call Service Prompt", "Prompt for Rotary Callers" in 2.3.1 Service Group

Language
 Specifies a language.

Default
None

Value Range
Selection from all installed languages (KX-TVA50: 3 languages, KX-TVA200: 10 languages)

Feature Manual References
2.2.44 System Prompts

DTMF
Specifies a selection number.

Default
None

Value Range
1–9/None

Selection Menu Wait Time
Specifies the length of time that the VPS waits for the caller to select a language by pressing the 
appropriate dial key. If this time period expires without the selection number being entered, the VPS 
uses the Primary Language.

Default
6 s
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Value Range
0 s–20 s

Feature Manual References
2.2.44 System Prompts

Selection Menu Repeat Cycle
Specifies the number of times the VPS will play the Multilingual Selection Menu.

Default
1

Value Range
1–3 times

Feature Manual References
2.2.33 Multilingual Service

Delay Time After Connected Received for Incoming
Specifies the length of time (in seconds) that the VPS waits after the line is connected for incoming 
calls before playing the prompt.

Default
0 s

Value Range
0 s–10 s

Feature Manual References
2.2.44 System Prompts

Delay Time After Connected Received for Outgoing
Specifies the length of time (in seconds) that the VPS waits after the line is connected for outgoing 
calls before playing the prompt.

Default
1 s

Value Range
0 s–10 s

Feature Manual References
2.2.44 System Prompts
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System Guidance
Specifies the parameters which vary depending on the language assigned as the System Guidance 
language. 
Follow the steps below to edit System Guidance.

1. Click Click to edit….

2. Select the desired Guidance No. 

3. Edit each parameter.

4. Click OK.

Select Language

Position of "AM/PM" in Time Stamp
Specifies the position of the "AM/PM" announcement.

Default
After (when the "Primary Language" is set to "English [US]")

Value Range
Before: the VPS announces "AM/PM" before the time, such as P.M. 3:42.

After: the VPS announces "AM/PM" after the time, such as 3:42 P.M..

24-h: the VPS announces the time in 24-h format, such as 15:42.

O'clock Prompt
Specifies when and if "O'clock" is announced.

Default
When 0 min (when the "Primary Language" is set to "English [US]")

Value Range
When 0 min: the VPS announces "O'clock" only on the hour, such "one o'clock".

Always: the VPS announces "O'clock" always.

None: No announcement

Month/Day Prompt
Specifies the order of the month and day for date announcements.

Default
MM:DD (when the "Primary Language" is set to "English [US]")

Value Range
MM:DD: Month and Day

DD:MM: Day and Month
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# Announcement Mode
Specifies the way of announcement for the "#" character when "English (US)" or "English (UK)" is 
selected as System Guidance.

Default
POUND (when the "Primary Language" is set to "English [US]")

Value Range
POUND, HASH

PBX Parameters
Specifies the parameters used to program the VPS for optimal signaling and performance with the 
PBX.

PBX Environment
Specifies how the VPS will initiate and control call transfers, setup outgoing calls, and control 
message waiting lamps on extensions. For KX-TVA50, the procedure for verifying the correct code 
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sequences for non-Panasonic KX-T series PBX is to manually execute the sequences from a single 
line telephone (SLT) with the PBX.

PBX Type
Specifies the type of PBX connected to the VPS.

Default
TDA/TAW

Value Range
TDA/TAW, TD816/TD1232/TA1232, TD500, TD308, TA624, Other*1

Integration Mode
Specifies the method of integrating the VPS with the PBX.

Default
DPT

Value Range
Inband: The PBX sends DTMF signals to the VPS to indicate the status of calls (busy, answered, 
disconnect, etc.). The DTMF code for each status must be set in the Inband Signaling Parameters; 
the settings of the PBX and VPS must match. If the PBX type is set to a KX-T series PBX, the Inband 
Signaling Parameters will automatically default to the proper codes. This is available with any of the 
following Panasonic KX-T series PBXs: TA624, TA824, TD816, TD1232/TA1232, TD500, and TDA/
TAW.

DPT: The VPS communicates with the PBX via the DPT interface. This is available with any of the 
following Panasonic KX-T series PBXs: TD816, TD1232/TA1232, TD500, TD308, and TDA/TAW.

APT: The VPS communicates with the PBX via the APT Interface. This is available with any of the 
following Panasonic KX-T series PBXs: TA624 and TA824.

Feature Manual References
2.1.1 Integration Types

Maximum Extension Number Length
Set this parameter to match the maximum number of digits which the connected PBX recognizes as 
an extension number.

Default
3

Value Range
2–5 digits

*1 The value range varies depending upon Country/Area and VPS model (KX-TVA50/KX-TVA200). Consult your dealer for more details.
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Extension Number of VPS Port 1–6 (KX-TVA50), 1–24 (KX-TVA200)
Specifies the PBX extension number of the port connected to the VPS. When configuring the VPS 
via the Auto Configuration feature, this parameter is set automatically.

Default
None

Value Range
2–5 digits

Feature Manual References
2.4.1 Auto Configuration (APT/DPT Integration Only)

Operator Transfer Sequence
Specifies the sequence for transferring calls to an operator's extension.

Default
FX

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Extension Transfer Sequence
Specifies the sequence for transferring calls to any extension except an operator's extension.

Default
FX

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)
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X: Extension Dialing

0–9, , #: Dial Code

Alternate Extension Transfer Sequence
Specifies the sequence for transferring calls to extensions in the Alternate Extension Group.

Default
FX

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Feature Manual References
2.2.1 Alternate Extension Group

Reconnect Sequence on Busy
Specifies the sequence for reconnecting to the caller if the called extension is busy.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Reconnect Sequence on No Answer
Specifies the sequence for reconnecting to the caller if the called extension does not answer.
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Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Reconnect Sequence on Refuse Call
Specifies the sequence for retrieving a call placed on hold after the extension (in Call Screening 
mode) has refused to accept it.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Light-On Sequence for Message Waiting Lamp
Specifies the sequence for turning on the Message Waiting Lamp at an extension.

Default
None

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection
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,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Feature Manual References
2.2.32 Message Waiting Notification—Lamp

Light-Off Sequence for Message Waiting Lamp
Specifies the sequence for turning off the Message Waiting Lamp at an extension.

Default
None

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Feature Manual References
2.2.32 Message Waiting Notification—Lamp

Message Waiting Lamp Retry Time
Specifies the number of times the VPS will retry turning on/off the Message Waiting Lamp of an 
extension. This parameter is enabled only when the integration mode is None or Inband mode.

Default
2

Value Range
0–5 times

Feature Manual References
2.2.32 Message Waiting Notification—Lamp

Message Waiting Lamp Interval Time
Specifies the time between retries when the VPS retires turning on/off the Message Waiting Lamp of 
an extension. This parameter is enabled only when the integration mode is None or Inband mode.
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Default
1

Value Range
1 min–60 min

Feature Manual References
2.2.32 Message Waiting Notification—Lamp

Call Waiting Sequence
Specifies the sequence for performing Call Waiting if the called extension is busy.

Default
1

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code

Release Sequence for Call Waiting
Specifies the sequence for releasing Call Waiting.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

X: Extension Dialing

0–9, , #: Dial Code
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Receiving Caller ID
Enables or disables the VPS to receive Caller ID from the PBX while receiving a call.

Default
Enable

Value Range
Disable, Enable

Waiting Time for Receiving Caller ID
Specifies the length of time that the VPS waits before receiving Caller ID from the PBX. This 
parameter is needed only when "Enable" is selected in "Receiving Caller ID".

Default
0 s

Value Range
0 s–10 s

Inband Signaling
Set these parameters only if the Integration Mode is set to "Inband" under "PBX Environment". If the 
PBX type is set to a KX-T series PBX, the Inband Signaling parameters will be automatically set to 
the default codes for the KX-T series PBX.

Note

• Default values below vary depending on the setting of "PBX type" in "PBX Environment".

Ringback
Specifies the DTMF signal used to indicate a ringback tone. Sent to the VPS when the extension 
dialed is ringing.

Default
1

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Busy
Specifies the DTMF signal used to indicate a busy tone. Sent to the VPS when the called extension 
is ringing.

Default
2
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Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Reorder
Specifies the DTMF signal used to indicate a reorder tone. Sent to the VPS when the VPS dials an 
invalid extension number or when the VPS dials a port number of the PBX that is connected to the 
VPS (i.e., the VPS calls itself).

Default
3

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

DND
Specifies the DTMF signal used to indicate a Do Not Disturb tone. Sent to the VPS when the dialed 
extension is in Do Not Disturb mode.

Default
4

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Answer
Sent to the VPS when the called extension answers the call.

Default
5

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Forward to VM Ringing
Specifies the DTMF signal used to indicate a Forward to VM Ring tone. Sent to the VPS when the 
dialed extension has set calls to be forwarded to the VPS and a VPS port is available to handle the 
call.

Default
6

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D
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Forward to VM Busy
Specifies the DTMF signal used to indicate a Forward to VM Busy tone. Sent to the VPS when the 
dialed extension has set calls to be forwarded to the VPS but no VPS ports are available to handle 
the call.

Default
7

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Forward to Other Extension
Specifies the DTMF signal used to indicate a Forward to Other Extension tone. Sent to the VPS when 
the dialed extension has set calls to be forwarded to another extension.

Default
8

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Confirmation 
Specifies the DTMF signal used to indicate a confirmation tone. Sent to the VPS when the Message 
Waiting Lamp was successfully turned on or off.

Default
9

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Disconnect
Specifies the DTMF signal used to indicate a disconnect tone. Sent to the VPS when the other party 
goes on-hook.

Default
#9

Value Range

Max. 16 digits consisting of 0–9, , #, and A–D

Digit Translation Table
Use the Digit Translation Table to translate Follow On ID Signals received from the PBX into the codes 
needed by the VPS. This translation table is only effective for incoming signals. Settings made here 
should correspond to the Follow On ID settings of the PBX.
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Inter-Digit Timeout
Defines the maximum length between the digits of a Follow On ID signal. If this time expires, the VPS 
will stop detecting Follow On ID for the call.

Default
1 s

Value Range
1 s–4 s

Translation Table (Table 1–Table 8)
Follow the steps below to edit the Translation Table

1. Click Click to edit….

2. Enter the digits sent from the PBX under "Input Digit" and the corresponding digits received by 
the VPS under "Output Digit" in the Translation Table dialog box.

3. Click OK.

Input/Output digit
Defines the input and output digits that are translated by the Digit Translation Table. Do not assign the 
same sequence of Input digits more than once; if this occurs, the VPS will use the first assignment.

Note

• The number of "K" signals assigned for a sequence of Input digits must be the same as the 
number entered in the sequence of Output digits.

Default
None

Value Range

Max. 20 digits consisting of 0–9, , #, A–D, S (Input digit only), and K

S: Skip (ignore) the code.

K: Keep the code as it is.
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Dialing Parameters

Number of Digits to Access Outside Line
This parameter should match the number of digits of the Line Access Code required by the PBX when 
making outside calls.

 
Example:

If the PBX requires callers to dial "9" to access a trunk (CO line), this parameter should be set as "1". 
This enables the VPS to recognize that an outgoing call setup sequence is completed once the initial 
"9" has been dialed (9-123-4567).

Default
1

Value Range
0–8 digits

Call Transfer No Answer Time
Specifies the length of time that the VPS waits before retrieving the transferred call when there is no 
answer at the destination extension.

Note

• Make sure that the duration of Call Transfer No Answer Time is longer than the duration of 
Call Forwarding No Answer Time at the PBX. Otherwise, the PBX may forward the call 
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immediately to the extension's Intercept Routing destination according to PBX 
programming, rather than return the call to the VPS.

Default
20 s

Value Range
10 s–60 s

Outgoing Call No Answer Time
Specifies the length of time that the VPS waits before concluding that there is no answer at the 
outside number called.

Default
30 s

Value Range
10 s–90 s

Pause Time for ","
Specifies the pause time for "," used in call sequences.

Default
1000 ms

Value Range
100 ms–9900 ms, units 100 ms

Pause Time for ";"
Specifies the pause time for ";" used in call sequences.

Default
3000 ms

Value Range
100 ms–9900 ms, units 100 ms

Outgoing Call Setup Sequence
Specifies the sequence of codes used by the VPS when calling a trunk (CO line). You can set a 
maximum of 16 digits. The default value is "T". "T" indicates that the VPS will dial the telephone 
number only after detecting a dial tone.

 
Example:

9, = (9) – 1 s wait – dial telephone number. "9" is the Trunk (CO Line) Access number.
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Default
T

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

0–9, , #: Dial Codes

Message Waiting Notification
Determines how essential Message Waiting Notification features are carried out.

Outgoing Call Ports
Specifies the port numbers used for Message Waiting Notification Device feature. The VPS makes 
outgoing calls using the port specified in this parameter. At least 1 port must be specified.

Note

• The maximum number of ports depends on the VPS model.
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Default
1-6 (KX-TVA50), 1-24 (KX-TVA200)

Value Range
1–6 (KX-TVA50), 1–24 (KX-TVA200)

Feature Manual References
2.2.31 Message Waiting Notification—Device

Message Waiting Lamp Ports
Specifies the port numbers used for Message Waiting Notification Lamp feature. The VPS turns on 
the Message Waiting Lamp of the extension using the port specified in this parameter. At least 1 port 
must be specified. 

Note

• The maximum number of ports depends on the VPS model.

Default
1-6 (KX-TVA50), 1-24 (KX-TVA200)

Value Range
1–6 (KX-TVA50), 1–24 (KX-TVA200)

Feature Manual References
2.2.32 Message Waiting Notification—Lamp

Message Waiting Lamp for Every Message
If set to "Yes", the VPS will turn on the Message Waiting Lamp of the extension each time a new 
message is recorded in the mailbox. This will occur even if the Message Waiting Lamp was not turned 
off from a previous message. This setting is useful when the first attempt is unsuccessful. If set to 
"No", the VPS will turn on the Message Waiting Lamp for the first message only. The VPS will not turn 
on the lamp for subsequent messages until the subscriber has accessed the VPS to retrieve the 
messages stored there.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.2.32 Message Waiting Notification—Lamp
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Max. Digits for Callback No.
Specifies the maximum number of digits the caller can enter as a callback number. This callback 
number will be displayed on beepers if "Beeper Callback No. Entry Mode" set to any values other than 
"Disable" (see "Beeper Callback No. Entry Mode" in 2.1.4 Notification Parameters).

Default
20

Value Range
1–48 digits

Feature Manual References
2.2.31 Message Waiting Notification—Device

Callback No. Entry Interdigit Time-out
Specifies the length of time the VPS will wait for the caller to press another dial key during Beeper 
Callback No. Entry. If the caller does not enter any digits within the specified time, the VPS will accept 
the digits already dialed by the caller as the Beeper Callback Number, then announce the dialed digits 
to the caller for confirmation.

Default
5 s

Value Range
1 s–10 s

Feature Manual References
2.2.31 Message Waiting Notification—Device

System Callback No.
Specifies the telephone number that will be displayed on the subscriber's beeper to indicate the 
phone number the subscriber should call back. The system callback number is displayed when 
"Beeper Callback No. Entry Mode" is set to "Disable", or when the caller does not enter his or her 
phone number when prompted to by the VPS. In order to use this feature, the callback number entry 
code "X" must be added to the end of the subscriber's beeper number when stored in the VPS.

Note

• If "Beeper Callback No. Entry Mode" is set to any values other than "Disable" (see "Beeper 
Callback No. Entry Mode" in 2.1.4 Notification Parameters), the callback number entered by 
the caller will display on the destination beeper. However, if the caller fails to enter a callback 
number, the System Callback No. will display instead.

Default
None

Value Range
Max. 32 digits
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Programming Manual References
2.1.4 Notification Parameters

Feature Manual References
2.2.31 Message Waiting Notification—Device

External Message Delivery
Determines how essential External Message Delivery features are carried out.

Retry Times
Specifies the number of times the VPS will attempt to deliver an external message when the 
destination is busy or does not answer.

Default
3

Value Range
0–9 times

Note

• The value range varies depending upon Country/Area.

Feature Manual References
2.3.11 External Message Delivery Service
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Busy Delay
Specifies the length of time (in minutes) the VPS waits to try to deliver an external message again 
when the destination is busy.

Default
3 min

Value Range
1 min–60 min

Feature Manual References
2.3.11 External Message Delivery Service

No Answer Delay
Specifies the length of time (in minutes) the VPS waits to try to deliver an external message again 
when the destination is not answering.

Default
60 min

Value Range
60 min–120 min

Feature Manual References
2.3.11 External Message Delivery Service

Outgoing Call Ports
Specifies the VPS ports used for the External Message Delivery feature.

Note

• The maximum number of ports depends on the VPS model.

Default
1-6 (KX-TVA50), 1-24 (KX-TVA200)

Value Range
1–6 (KX-TVA50), 1–24 (KX-TVA200)

Feature Manual References
2.3.11 External Message Delivery Service

Message Length
Specifies the maximum length (in minutes) messages recorded for the External Delivery Message.
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Default
3 min

Value Range
1 min–6 min

Feature Manual References
2.3.11 External Message Delivery Service

Max. Messages for Mailboxes
Specifies the maximum number of External Delivery Messages that can be stored in one mailbox.

Default
3

Value Range
1–100 msgs

Feature Manual References
2.3.11 External Message Delivery Service

System External Message Delivery Duration Time
Specifies the maximum length of External Message Delivery calls. The timer begins counting when 
the called party answers the call, and if the caller has not pressed the appropriate dial key to initiate 
message playback, the VPS terminates the call when this timer expires.

Default
3 min

Value Range
1 min–9 min

Feature Manual References
2.3.11 External Message Delivery Service

Company Telephone No.
Specifies the company's telephone number. When the recipient has failed to retrieve the sender's 
message because of he or she did not enter the correct password, the VPS announces the 
company's telephone number to the caller. The caller can later call the company for assistance or to 
speak to the message sender.

Default
None
Programming Manual 165



2.5 System Parameters
Value Range
Max. 32 digits

Intercom Paging Parameters
VPS Intercom Paging functions in conjunction with the Intercom Paging feature of the PBX. It allows 
the VPS to page the called party (announce the caller's name, line number, etc.) while the caller is 
placed on hold. To utilize this feature, Intercom Paging must be available for the PBX, and the VPS 
must be properly programmed. This feature is available for APT/DPT Integration only.

Intercom Paging Sequence
Specifies the intercom paging sequence used to activate the Intercom Paging feature of the PBX. The 
settings made here must match the settings of the PBX. The sequence can be a combination of 7 
letters and 12 dial codes.

Default
FX
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Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

X: Pager Dialing

0–9, , #: Dial Codes

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Release for Intercom Paging
Specifies the intercom paging release sequence. The settings made here must match the settings of 
the PBX. The sequence can be a combination of 7 letters and 12 dial codes.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

X: Pager Dialing

0–9, , #: Dial Codes

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

No Answer Time for Intercom Paging
Specifies the length of time (in seconds) the VPS waits before concluding Intercom Paging when 
there is no answer. The VPS will return to the caller if the paged party does not respond before this 
timer expires.

Default
5 s
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Value Range
1 s–30 s

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Announcement Repeat Cycle
Specifies the number of times the VPS announces the page.

 
Example:

"I have a call for (subscriber's name)".

Default
1

Value Range
1–3 times

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Intercom Paging Retry
Specifies the number of times to retry paging when the called subscriber has set Incomplete Call 
Handling to "Intercom Paging" and the subscriber is busy or if there is no answer.

Note

• This setting applies only when the subscriber has enabled "Intercom Paging" in Incomplete 
Call Handling Status.

Default
2

Value Range
1–10 times

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Caller Recorded Name Announcement Mode
Determines whether or not the VPS announces the caller's name during paging. (In order for the 
name to be announced, it must be recorded beforehand.)

Default
Disable
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Value Range
Disable, Enable

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Paging Code
Specifies the intercom paging code. The settings made here must match the settings of the PBX.

Note

• Each subscriber's Intercom Paging Group Number is determined based on his or her COS.

Default
All groups: None

Selective (Paging Code for Group 1-32): 33 + Group No.

Value Range

Max. 16 digits consisting of 0–9, , # for all/each group

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Fax Management
You can program the VPS to automatically detect incoming fax calls and forward those calls to a fax 
extension. You can specify a maximum of 2 fax extensions as the destination for faxes; if the main fax 
extension is not available to receive a fax, the VPS will forward the fax call to the alternate fax 
extension.
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Automatic Transfer of Incoming Fax Call
Enables or disables the detection of incoming fax calls.

Note

• The VPS can detect incoming fax signals during the first 30 seconds after it answers 
incoming calls.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.22 Fax Management

Main Fax Extension No.
Specifies the extension number of the main fax machine.

Default
None
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Value Range
2–5 digits

Feature Manual References
2.2.22 Fax Management

Alternate Fax Extension No.
Specifies the extension number of the alternate fax machine. When the main fax extension is busy or 
does not answer within the time specified under "Fax No Answer Time", the VPS forwards the fax call 
to the alternate fax extension.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.22 Fax Management

Fax No Answer Time
Specifies the length of time (in seconds) that the VPS waits for the main or alternate fax extension to 
answer a fax call before taking other action, such as notifying the fax manager that the fax could not 
be received.

Default
10 s

Value Range
5 s–60 s

Feature Manual References
2.2.22 Fax Management

Fax Manager Mailbox No.
Specifies the mailbox number of the Fax Manager. The VPS will notify the Fax Manager of the status 
of fax calls depending upon the settings of the "Fax No Answer Coverage Mode" and "Fax Notification 
Mode" parameters.

Default
None

Value Range
2–5 digits
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Feature Manual References
2.2.22 Fax Management

Fax No Answer Coverage Mode
Determines what action the VPS takes when an incoming fax call could not be answered by the main 
or alternate fax extension. The VPS can announce to the Fax Manager the number of unanswered 
fax calls. The number announced is the number of unanswered fax calls since the last time the VPS 
notified the Fax Manager. This announcement is heard when the Fax Manager logs in to his or her 
mailbox.

Default
No

Value Range
No: The VPS will not notify the Fax Manager when fax calls were not answered.

Mbx: The VPS will announce the number of unanswered fax calls to the Fax Manager when the Fax 
Manager logs in to his or her mailbox.

Extn: The VPS will announce the number of unanswered fax calls to the Fax Manager by calling the 
Fax Manager's extension.

Feature Manual References
2.2.22 Fax Management

Fax Notification Mode
Determines what action the VPS takes when an incoming fax call is successfully received by the main 
or alternate fax extension. The VPS can announce to the Fax Manager the number of received fax 
calls. The number announced is the number of received fax calls since the last time the VPS notified 
the Fax Manager.

Default
No

Value Range
No: The VPS will not notify the Fax Manager when fax calls are answered. 

Mbx: The VPS will announce the number of successfully received fax calls to the Fax Manager when 
the Fax Manager logs in to his or her mailbox.

Extn: The VPS will announce the number of successfully received fax calls to the Fax Manager by 
calling the Fax Manager's extension.

Feature Manual References
2.2.22 Fax Management
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Disconnect Parameters

Maximum Silence Time
Specifies the length of silence detected by the VPS before the VPS disconnects the call.

Default
10 s

Value Range
0 s–60 s

Maximum Continuous Tone Time
Specifies the length of time the VPS waits when a continuous tone is detected before it disconnects 
the call.

Default
6 s

Value Range
0 s–60 s
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Maximum Cyclic Tone Time
Specifies the length of time the VPS waits when a cyclic tone is detected before it disconnects the call.

Default
6 s

Value Range
0 s–60 s

Maximum Call Duration
Specifies the maximum duration of calls. If the VPS detects no DTMF signals for the specified amount 
of time, it terminates the call.

Default
10 min

Value Range
0 min–60 min

Transfer to Outside
These parameters determine how the VPS will transfer calls to trunk (CO line) via the following 
features: Call Transfer Service, Custom Service, Personal Custom Service, Caller ID Callback.
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Outside Transfer Sequence

Call Transfer to Outside Sequence
Specifies the sequence the VPS uses to transfer calls to trunks (CO lines).

Default
FND

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

Feature Manual References
2.2.7 Call Transfer to Outside

Call Transfer to Outside Reconnect Sequence on Busy
Specifies the sequence the VPS uses to reconnect the line when the transferred party is busy.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

Feature Manual References
2.2.7 Call Transfer to Outside
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Call Transfer to Outside Reconnect Sequence on No Answer
Specifies the sequence the VPS uses to reconnect the line when the transferred party does not 
answer.

Default
F

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

Feature Manual References
2.2.7 Call Transfer to Outside

EFA Transfer Sequence
Specifies the sequence the VPS uses to transfer calls to trunks (CO lines) using EFA (External 
Feature Access). This setting should match the setting of the PBX.

Default

F 60TN

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

EFA Transfer Reconnect Sequence on Busy
Specifies the sequence the VPS uses to reconnect the line when the party transferred with EFA 
(External Feature Access) is busy. This setting should match the settings of the PBX.
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Default

F 60

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

EFA Transfer Reconnect Sequence on No Answer
Specifies the sequence the VPS uses to reconnect the line when the party transferred with EFA 
(External Feature Access) does not answer. This setting should match the settings of the PBX.

Default

F 60

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, , #: Dial Codes

Call Transfer to Outside Answer Mode
Specifies the answering method the VPS uses to detect whether the destination party has answered 
the transferred CO call.

Default
Guidance

Value Range
Analyze: the VPS monitors the status of the trunk (CO line), recognizes that the destination party 
goes off-hook, and connects the line.

Guidance: the VPS plays the following guidance before connecting the line to the destination party: 
"You have a call. To answer the call, press 1. Otherwise, press 2 and hang up." If the destination party 
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presses "1", he or she will be able to answer the transferred CO call. The VPS continues playing this 
guidance for the time specified in "Outgoing Call No Answer Time" in "Dialing Parameters". If the 
transferred party does not answer the call within this time, the VPS considers it as a No Answer call.

Feature Manual References
2.2.7 Call Transfer to Outside

Ignore Received First DTMF
If the PBX sends a DTMF signal to the VPS when the VPS attempts to transfer a call to an outside 
telephone, set this parameter to "Enable".

Default
Enable

Value Range
Disable, Enable

Trunk Group
Specifies the parameters for each Trunk Group No. 

Follow the steps below to edit the Trunk Group:

1. Click Click to edit….

2. Select the desired Trunk Group No. (1–64).

3. Edit each parameter in the Trunk Group dialog box.

4. Click OK.

EFA Transfer
Effective for DPT Integration only. Specifies whether or not the VPS uses EFA (External Feature 
Access) when transferring incoming CO calls to a trunk (CO line). If set to "Enable", the VPS transfers 
incoming CO calls to a trunk (CO line) according to "EFA Transfer Sequence" specified in "Transfer 
to Outside". If set to "Disable", the VPS transfers incoming CO calls to a trunk (CO line) according to 
"Call Transfer to Outside Sequence" specified in "Transfer to Outside".

Default
Disable

Value Range
Disable, Enable

Caller ID Callback
Specifies whether or not the VPS allows a subscriber to call back the party who left a message in his 
or her mailbox by using the caller ID information sent from the PBX. This setting applies to the trunk 
(CO line) number used when the message with Caller ID information was left in his or her mailbox.

Default
Disable
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Value Range
Disable, Enable

Outside Line Access Sequence for Caller ID Callback 
Specifies the sequence of Trunk (CO Line) Access numbers for Caller ID Callback. This parameter is 
available when the VPS executes Caller ID Callback without using EFA.

Default
9T

Value Range

Max. 16 digits consisting of 0–9, , # and special codes

D: Disconnecting

F: Hook Flash

R: Ringback Tone Detection

T: Dial Tone Detection

,: Dial Pause for 1 s (default)

;: Dial Pause for 3 s (default)

0–9, , #: Dial Codes

Use Caller-ID Modify Table No.
Specifies which Caller ID Modify Table is used when the VPS converts the Caller ID Number sent 
from the PBX to the VPS.

Default
1

Value Range
1–4

Number of Digits in Telephone Number
Specifies the number of digits for Local Area Telephone Numbers. According to this parameter, a call 
number sent from the VPS is determined whether the local call or long distance call.

Default
8

Value Range
1–20

Caller-ID Modify Table No.1–No.4
A maximum of 4 Caller ID Modify tables can be assigned.
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Local Area/International Call Code
Specifies the parameters for each Local Area/International Call Code.

Follow the steps below to edit Local Area/International Call Code:

1. Click Click to edit….

2. Select the desired Local Area/International Call Code No. (1–10).

3. Edit each parameter in the Local Area/International Call Code dialog box.

4. Click OK.

Local Area Code/International Code
Specifies the local area/international codes that are used when the VPS converts the Caller ID 
Number sent from the PBX to the VPS.

Default
None

Value Range
Max. 6 digits consisting of 0–9

Remove Digits
Specifies the number of digits to be deleted from the telephone number (sent from the PBX) to make 
up a telephone number for a local area/international call. Digits are removed from the beginning of 
the received digits.

Default
0

Value Range
0–9

Additional Digits
Specifies the number to be added to the telephone number (sent from the PBX) to make up a 
telephone number for a local area/international call. The number is added to the beginning of the 
received digits.

Default
None

Value Range

Max. 4 digits consisting of 0–9, , #
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Long Distance Call

Remove Digits (0–9)
Specifies the number of digits to be deleted from the telephone number (sent from the PBX) to make 
up a telephone number for a long distance call. Digits are removed from the beginning of the received 
digits.

Default
0

Value Range
0–9

Additional Digit
Specifies the number to be added to the telephone number (sent from the PBX) to make up a 
telephone number for a long distance call. The number is added to the beginning of the received 
digits.

Default
None

Value Range

Max. 4 digits consisting of 0–9, , #

VM Menu
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Number of Ports for VM Menu Service
Specifies the total number of ports that can be used simultaneously to provide VM Menu service for 
subscribers.

Note

• If too many subscribers try to access VM Menu at the same time, it will not operate properly. 
In order to prevent it, lower the number of ports to be able to access VM menu.

Default
12

Value Range
0–24

Feature Manual References
2.3.36 VM Menu (DPT Integration Only)

E-mail Integration
E-mail Integration allows the VPS to send new message notification or to send recorded voice 
messages as file attachments to subscribers via e-mail. The following settings must be made in order 
for the VPS to use E-mail Integration features. Consult the LAN administrator for the appropriate 
settings.
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Follow the steps below to edit E-mail Integration:

1. Set E-mail Integration to Enable.

2. Enter an e-mail address next to Mail Address.

Note

• We recommend entering an administrator's e-mail address here. If there are any errors 
when the VPS tries to send e-mail messages, error messages will be sent to this address.

3. Enter the name that will appear in e-mail messages sent from the VPS next to Full Name. This 
name should indicate that the message came from the VPS.

4. Enter the outgoing mail server address next to SMTP Server Address.

Note

• If authentication is required when accessing the outgoing mail server (SMTP server), make 
the appropriate settings under Advanced Settings.

• When sending e-mails, the sent date is stamped to e-mails at the SMTP server connected 
to the VPS, otherwise, depending on the setting of the e-mail application the receiver uses
Programming Manual 183



2.5 System Parameters
E-mail Integration
If set to "Enable", subscribers are able to utilize E-mail Integration features.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.20 E-mail Integration

Mail Address 
Specifies the mail address of VPS. We recommend entering an administrator's e-mail address here. 
If there are any errors when the VPS tries to send e-mail messages, error messages will be sent to 
this address.

Default
None

Value Range
Max. 128 characters

Feature Manual References
2.2.20 E-mail Integration

Full Name
Specifies the full name that will appear in e-mail messages sent from the VPS.

Default
None

Value Range
Max. 64 characters

Feature Manual References
2.2.20 E-mail Integration

SMTP Server Address
Enter the IP address of the outgoing e-mail server used by the VPS.

Default
None
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Value Range
X.X.X.X (X=0–255)

Feature Manual References
2.2.20 E-mail Integration

Maximum Message Length
Specifies the maximum length of voice messages sent as e-mail attachment.

Note

• If you attach a voice message that is longer than this setting, surplus parts of the message 
may be discarded when sending the e-mail.

Default
5 min

Value Range
1 min–30 min

Feature Manual References
2.2.20 E-mail Integration

Advanced Settings

SMTP Server Port No.
Specifies the port number for the outgoing mail server.

Default
25

Value Range
1-65535

POP Server Port No.
Specifies the port number for the incoming mail server.

Default
110

Value Range
1-65535
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POP Before SMTP
If set to "Enable", POP Before SMTP authentication is used for outgoing mail server. For 
authentication, username and password are required.

Default
Disable

Value Range
Disable, Enable

POP Before SMTP Username
Specifies the user name for POP Before SMTP authentication.

Default
None

Value Range
Max. 64 characters

POP Before SMTP Password
Specifies the password for POP Before SMTP authentication.

Default
None

Value Range
Max. 64 characters

SMTP Authentication
If set to "Enable", SMTP Authentication is used for outgoing mail server. For authentication, username 
and password are required.

Default
Disable

Value Range
Disable, Enable

SMTP Authentication Username
Specifies the user name for SMTP Authentication.

Default
None
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Value Range
Max. 64 characters

SMTP Authentication Password
Specifies the password for SMTP Authentication.

Default
None

Value Range
Max. 64 characters

SMTP Over SSL
Determines whether or not to use the SSL connection for encryption when sending e-mails.

Default
Disable

Value Range
Disable, Enable

POP Over SSL
Determines whether or not to use the SSL connection for encryption when receiving e-mails.

Default
Disable

Value Range
Disable, Enable
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2.6 Hardware (H/W) Settings

2.6.1 Global Parameters

Global parameters define the settings that affect integration with the PBX.

Flash Time
For Inband and No Integration only. Specifies the length of time the hook switch must be pressed 
before the PBX will recognize it as a flash hook signal. The settings made here should match the 
settings of the PBX.

Default
600 ms

Value Range
100 ms, 300 ms, 600 ms, and 900 ms

CPC Signal 
For Inband and No Integration only. Specifies the minimum time necessary to detect an interruption 
in the CPC (Calling Party Control) signal received from the PBX. The VPS is able to determine that 
the line has been disconnected when it detects an interruption of the CPC signal. The settings made 
here should match the settings of the PBX.
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Default
None

Value Range
None, 6.5 ms, 150 ms, 300 ms, 450 ms, 600 ms, and 900 ms

Disconnect Time
Specifies the length of time the line will be unavailable after a call has ended.

Default
2 s

Value Range
1 s–8 s

Delay After Dialing Before Analysis
Specifies the length of time between the end of call and the start of "Call Progress Tone" detection 
when an outgoing call is dialed.

Default
0 ms

Value Range
0 ms–20000 ms, units 100 ms 

Maximum Time to Wait for Dial Tone
Specifies the length of time that the VPS waits for dial tone detection.

Default
5000 ms

Value Range
500 ms–20000 ms, units 100 ms

Dial Start Mode
Specifies whether dialing starts after a dial tone is detected or after the time specified in "Off-hook 
Delay" has passed.

Default
Delay Mode

Value Range
Dial Tone Mode, Delay Mode
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Off-hook Delay
Specifies the length of time that passes before dialing starts. This setting is only needed when "Dial 
Start Mode" is set to "Delay Mode".

Default
3000 ms

Value Range
500 ms–20000 ms, units 100 ms

Delay After Dialing Before On-hook
Specifies the length of time that the VPS waits for an answer when making an outside call. If no 
answer is detected, the VPS disconnects the call.

Default
60 s

Value Range
0 s–250 s

DTMF Cut Length
Specifies the length of time for DTMF to be deleted when it is detected while recording.

Default
110 ms

Value Range
0 ms–500 ms

Minimum Message Length
Specifies the minimum message recording length. Messages shorter than the specified minimum 
recording length are discarded from the mailbox.

Default
2 s

Value Range
0 s–9 s

Call Progress Tone Detection for Inband Mode
This setting determines whether the VPS detects Call Progress Tones during Inband Integration. If 
set to "Enable", Call Progress Tones are detected in addition to DTMF signals.
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Default
Enable

Value Range
Disable, Enable
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2.7 Reports
The System Administrator can generate various system reports in order to monitor VPS operations.

Reports can be displayed on a PC, printed, or exported.

Note

• In order to use the "Schedule Options" feature, you need to upgrade the KX-TVA 
Maintenance Console software on the PC connected to the VPS.

– Mailbox Information Report

– Call Account Report

– Port Usage Report

– HDD (Memory) Usage Report

– Mailbox Usage Report

– Fax Call Report

– Call Handling Statistic Report

– Custom Service Report

– Message Status Report

– Subscriber Setup Report

– Security Information Report

– Hourly Statistic Report

– E-mail Report

Follow the steps below for Reports screen:

[View]

1. Select the desired report in Reports screen.

2. Click View Report.

[Switching Between Graph and Table View]

Select either "Table" or "Graph" in View as:

The following reports can be viewed as either of Table or Graph format:

a) Call Account Report

b) Port Usage Report

c) HDD (Memory) Usage Report

d) Mailbox Usage Report

e) Call Handling Statistics Report

[Print]

1. Click Print….

2. Navigate to the printer to print a report

[Export]

1. Click Export….

2. Specify or navigate to the folder where to export a report.

Report Data Clear
For each report, all data can be cleared. Follow the steps below for Report Data Clear.
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1. Click Reports Data Clear tab at the bottom of Report screen.

2. Select the desired report from Report Parameters.

3. Click Report Data Clear.
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2.7.1 Mailbox Information Report

The mailbox information report displays configuration parameters (from owner's extension to e-mail 
options) for a specified mailbox or a range of mailboxes.
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Mailbox Information Report JUL-28-2004 11:30 AM
For Mailbox Range: 210 to 215 

Extension: 210 

Incomplete Call Handling for No Answer:

First Name: JOHN  

Leave a message Disable
Transfer to a covering extension Disable
Page the mailbox owner by intercom paging Disable
Notify the mailbox owner via a beeper Enable
Transfer to operator Disable
Return to top menu Disable
Transfer to specified custom service menu Disable

Last Name: WILIAMS 

Incomplete Call Handling for Busy 

Password: ***** 
Class of Service: 1 
Covering Extension: 230 
Interview Mailbox: 777 
Call Transfer Sequence: FTXD 
No Answer Time (sec)  30
Call Transfer Status: Call Screening

Notification Parametes
Message Waiting Lamp: Enable
Beeper Callback No. Entry Mode: Before Message Recording 
Device Notification for Unreceived Message: Yes
Notification Schedule 

[ Device 1] 

Dial Number: 96127494 
Type of Device: Telephone 
No. of Retries (times): 3 
Busy Delay Time (min): 2
No Answer Delay Time (min): 60 

Mailbox 210

Leave a message Disable
Transfer to a covering extension Disable
Page the mailbox owner by intercom paging Disable
Notify the mailbox owner via a beeper Enable
Transfer to operator Disable
Return to top menu Disable
Transfer to specified custom service menu Disable

Notification Type: Only Urgent Messages

Use Mode: Continuously 

[ Device 2] 

Dial Number: 96127494 
Type of Device: Telephone 
No. of Retries (times): 3 
Busy Delay Time (min): 2

Notification Type: Only Urgent Messages
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2.1 Mailbox Settings

Auto Forwarding Status

Mailbox Number: 120 
Delay Time: 00:30 
Forward Mode: Move

:

External Message Delivery 
Active: Yes 

No Answer Delay Time (min): 60 
Use Mode: Scheduled 

02:00AM-11:00AM 13:00PM-22:00PM [Mon] 
02:00AM-11:00AM 13:00PM-22:00PM [Tue] 
02:00AM-11:00AM 13:00PM-22:00PM [Wed] 
02:00AM-11:00AM 13:00PM-22:00PM [Thu] 
02:00AM-11:00AM 13:00PM-22:00PM [Fri] 
02:00AM-11:00AM [Sat] 

[Sun] 

[ Device 3] 

Dial Number: 96127494 
Type of Device: Telephone 
No. of Retries (times): 3 
Busy Delay Time (min): 2
No Answer Delay Time (min): 60 

Notification Type: Only Urgent Messages

Use Mode: Continuously 

Device Notification Timer 
Device Start Delay Time (min): 60
Device Interval Time between Device1 and Next Device (min): 60

Device Interval Time between Device2 and Next Device (min): 60
Device Interval Time between Device3 and Next Device (min): 60

Prompt Mode: System 

Active: Yes

Personal Distribution List
[List 1] 
Description: 
Personal Distribution List Name:

ABCDEFGHI
Recorded

Members:
101 PAUL WILLER
102 STEAVY PERRY

[List 2] 
Description: 
196 Programming Manual



2.7 Reports
Feature Manual References
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2.7 Reports
2.7.2 Call Account Report

The call account report displays information about outgoing call activity. Information can be shown by 
port or by mailbox. The report includes date, starting time, used port, connection time, called 
telephone number, call type, exit status of each callout, total callouts number and the connection time 
for local or long distance call, and total number of outgoing calls.

Feature Manual References
2.4.7 System Reports

Call Account Report (Group calls by Mailbox) JUL-28-2004 11:30 AM 
For Mailbox Range: 200 to 210 
From: JUL-01-2004 09:30 AM 

MAILBOX 200 

Date Time Port Connect Time Number Type Exit Status

JUL-01-02 06:04 PM 12 00:01:12 7893435678 Local Called Out
JUL-06-02 11:45 PM 18 00:00:47 18007597243 Long Called Out
JUL-12-02 09:32 AM 3 00:02:03 7039783232 Local Transferred 

Total Local Calls: 2 00:03:15 
Total Long Distance Calls: 1 00:00:47 
Total Calls From Mailbox 200: 3 00:04:02 

MAILBOX 201
:

198 Programming Manual



2.7 Reports
2.7.3 Port Usage Report

The port usage report displays information about each port, such as connection time and percentage 
of time which each port was busy.

Feature Manual References
2.4.7 System Reports

Port Usage Report JUL-28-2004 11:30 AM
From: JUL-01-2004 09:30 AM

Port No.
External Message

Delivery 
Message Device 

Notification Receive Connect Time 
Percentage of
Connect Time (%) 

1 8 4 84 00:05:19 47.20
2 4 1 21 00:01:35 14.05 
3 1 0 13 00:03:02 26.92
4 0 0 4 00:01:20 11.83 

Total 28 42 359 00:11:16 100.00 

: : : : :
: : : : : 

Full-line Time 00:00:00
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2.7 Reports
2.7.4 HDD (Memory) Usage Report

The HDD (memory) usage report indicates the amount of disk storage used and the amount of 
available disk space. Disk space is expressed in minutes. The following statistics are also displayed:

– The number of messages that were recorded by callers and were copied since the last clearing 
of this report.

– The number of messages that were copied since the last clearing of this report.

– The number of messages that were deleted by subscribers since the last clearing of this report.

– The number of messages that expired and were removed by the VPS since the last clearing of 
this report.

Feature Manual References
2.4.7 System Reports

HDD Usage Report JUL-28-2004 11:30 AM

Drive Number 
Available Recording
Time (min) 

Used Recording
Time (min) 

Percentage of 
Disk Usage (%) 

1 120 6 5.00 

From: JUL-01-2004 10:00 AM 

Total New Message Total Copy Message Total Delete Message Total Expired Message

Messages 10 0 10 0 
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2.7 Reports
2.7.5 Mailbox Usage Report

The mailbox usage report displays information for a specified mailbox or range of mailboxes, including 
the number of recorded messages, the total time of outgoing calls, external messages, message 
notification, and group message delivery.

Note

• Specify the range or the mailbox number. For example, to obtain information on mailboxes 
200 to 209, Type [200] and press RETURN, or [200] [,] [209] and press RETURN.

• New MSGs, Received MSGs, and ED MSGs are current status indications. All else are 
accumulated indications since the last clearing of this report.

Feature Manual References
2.4.7 System Reports

Mailbox Usage Report JUL-28-2004 11:30 AM 

MAILBOX 200 JONE BLUE 
Current New Message Counts 4 
Current Received Message Counts 6 
Current EMD Message Counts 0 

From: JUL-01-2004 09:30 AM 

Subscriber Access Time 00:00:40 
Date Time Port No.  Connect Time Exit Status

JUL-01-04 10:12 AM 12 00:00:08 Disconnect 
JUL-05-04 04:32 PM 3 00:00:15 Logoff 
JUL-09-04 01:23 PM 5 00:00:07 Logoff 
JUL-10-04 07:03 PM 12 00:00:10 Cyclic Tone

MAILBOX Used Time 00:00:12 of 01:40:00 (0.2% Used) 

External
Message Delivery 

Message
Notification 

Interview
Message 

Group 
Message 

Auto 
Forward

Feature Usage 11 31 20 14 22 

Long Distance Local Beeper Extension 
Outgoing Call 6 13 0 28
(Time) 00:05:10 00:10:45 00:00:00 00:31:21 

Received Message Deleted Message Expired Message 
Message Received 42 30 11 
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2.7 Reports
2.7.6 Fax Call Report

The fax call report displays information about faxes received by the VPS and transferred to a fax 
extension. It includes the fax reception date, the port number used, and the fax transfer status for a 
maximum of 64 fax messages.

Feature Manual References
2.4.7 System Reports

Fax Call Report JUL-28-2004 11:30 AM
From: JUL-01-2004 09:30 AM 

Date Time Port Fax-1 Fax-2 

JUL-01-04 11:15AM 1 Connect - 
JUL-04-04 07:58PM 12 Busy No Answer
JUL-15-04 10:23AM 1 Busy Connect 
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2.7 Reports
2.7.7 Call Handling Statistic Report

The call handling statistic report displays both a summary of and details of VPS activity over a 
specified period of time for the Automated Attendant service. This report includes the total number of 
incoming calls, transferred calls, held calls, calls which left a message, the result of transferred calls, 
etc.

Call Handling Statistics Report JUL-28-2004 11:30 AM
From: JUL-01-2004 09:30 AM

Total Calls Answered: 23083
Percentage (%)

Caller Dialled During Greeting 20797 90.10 
Caller Hung Up During Greeting 1529  6.62 
Greeting Complete 757 3.28 

Total Transfers: 19047 
Transfer by Timeout 168 0.88 
"0" key for Operator  2106  11.06 
Single Key Requests (except "0") 1302  6.84 
Full Extension Requests 10546 55.37 
Left a Message for a Subscriber 0 0.00 
Logon Sessions 4761  25.00 
Fax Call Answering 164 0.86 

Result of Transfers: 8943 
Line Busy 631 7.06 
Ring No Answer 2876  32.16
Call Blocking 443 4.95
Rejected 10 0.11
Illegal Number 91 1.02
Call Connected 4892  54.70

Hold Initiated: 77 
Call Connected 69 89.61 
Hold Abandoned 8 10.39

Diverted Calls: 8196 
Message Taken 7287  88.91 
External Transfer 156 1.90 
Intercom Paging 23 0.28 
Call a Beeper 4 0.05 
Transfer to Custom Service 0 0.00
Disconnected 726 8.86 

Total Usage in Minutes 59346 
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Feature Manual References
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2.7 Reports
2.7.8 Custom Service Report

The Custom Service report displays information such as Custom Service settings, message 
recording status, number of access, time of access, and number of access to each key.

Programming Manual References
2.4.4 Custom Service

Feature Manual References
2.4.7 System Reports

Custom Service Report JUL-28-2004 11:30 AM 
From: JUL-01-2004 09:30 AM 

Custom 1 

Type :  Menu&Transfer 
Prompt : Recorded Language :  English 
Access : 34 Abandon :  6 Average :  00:32:27 
[Access Counts] 

[Key 1] : 8 [Key 2] : 11 [Key 3] : 0 

[No Input] : 3 

[Key 4] : 0 [Key 5] : 0 [Key 6] : 0 
[Key 8] : 0 [Key 9] : 0 
[Key 0] : 12 [Key #] : 0 

Custom 2 

Description :

[Key 7] : 0 
[Key   ] : 0 
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2.7 Reports
2.7.9 Message Status Report

The message status report provides the status of all messages of specified subscribers.

Feature Manual References
2.4.7 System Reports

Message Status Report JUL-28-2004  11:30 AM
For Mailbox Range: 245 to 245 

New Messages 

JUL-27-04 11:15 AM 345 00:00:23 
JUL-27-04 03:23 PM 4457896091 CHRIS JONES 00:01:09 

Total New Messages: 2 

Saved Messages 

Message Recording 
Date 

Message Recording
Time 

Caller ID Number  or
Mailbox Number

Caller ID Name or
Mailbox Last name

Message Length
(sec) 

JUL-12-04 09:42 AM 7986213456 JEFF CHIN 00:00:26 
JUL-19-04 10:24 PM 211 00:00:15 

Total Saved Messages: 2 

MAILBOX 245 Lisa Ruiz 

Message Recording 
Date 

Message Recording
Time 

Caller ID Number or
Mailbox Number

Caller ID Name or
Mailbox Last name

Message Length
(sec) 
206 Programming Manual



2.7 Reports
2.7.10 Subscriber Setup Report

The subscriber setup report displays the basic settings (owner's name, password, personal greeting, 
etc.) for a specified mailbox or range of mailboxes.

Feature Manual References
2.4.7 System Reports

Subscriber Setup Report JUL-28-2004  11:30 AM
For Mailbox Range: 300 to 310 

Mailbox Name Greetings Owner Name Password Last Access 
300 ANNE MINOR Recorded Default JUL-23-04 10:10 AM
301 CHRIS JONES --- - Default JUL-21-04 02:24 PM
302 LISA RUIZ --- Recorded Changed JUL-28-04 08:00 AM

--- 
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2.7 Reports
2.7.11 Security Information Report

The security information report displays information about mailbox accesses. The report includes the 
date of the last change and last access, number of total accesses, login, and failed accesses.

Feature Manual References
2.4.7 System Reports

Security Information Report JUL-28-2004 11:30 AM
For Mailbox Range: 300 to 310 

Mailbox Last Change Last Access 
Total Number Access 

Access of Login Failure 

300 FEB-23-04 JUL-12-04 8 7 1 12.50
301 MAR-12-04 JUL-21-04 21 18 3 14.29
302 JUL-01-04 JUL-27-04 32 22 10 31.25

Failure (%) 
Percentage of

310 JUL-16-04 JUL-04-04 123 103 20 16.26
: : : : : : : 
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2.7 Reports
2.7.12 Hourly Statistics Report

The hourly statistics report displays information about the number of incoming or outgoing calls, the 
connected time per hour, etc.

Feature Manual References
2.4.7 System Reports

Hourly Statistics Report JUL-28-2004 11:30 AM
From : JUL-01-2004 09:30 AM 

Date Time Periods 
External Message

Delivery 
Message Notification

Device Receive Connect Time 

JUL-01-04 09:00 PM 0 
 

1 23 02:10:19 
10:00 PM 1 

 
5 32 03:22:32 

11:00 PM 0 13 28 02:40:03 
12:00 AM 0 

 
3 13 01:56:39 

01:00 AM 1 
 

9 24 02:19:26 
02:00 AM 0 17 22 02:24:41 

:

JUL-02-04 09:00 AM 0 
 

1 23 02:10:19 
10:00 AM 1 

 
5 32 03:22:32 

11:00 AM 0 13 28 02:40:03 
:
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2.7 Reports
2.7.13 E-mail Report

The e-mail report displays mailbox numbers, dates, times, message status and addresses to which 
the VPS sent message waiting notification by e-mail.

Programming Manual References
2.1.11 E-mail Option

Feature Manual References
2.4.7 System Reports

Email Report JUL-01-2004 11:30 AM 

Mailbox Date Time Message Status Address 
310 JUL-01-04 11:15 AM Move johnsmith@abcdefg.com 
138 JUL-04-04 07:58 PM Move paulparker@abcdefg.com
120 JUL-15-04 10:23 AM Copy sarah1205@12345.com

From: JUL-01-2004 09:30 AM
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2.8 System Security
2.8 System Security
System security settings are divided into the following categories:

– Administrator

– Subscriber

2.8.1 Administrator

Password
Assigns the password required when connecting to the VPS using KX-TVA Maintenance Console.

Follow the steps below to change the password:

1. Click Click to change password….

2. Enter a new password in Enter new password:.

3. Enter the new password in Confirm new password:.

4. Click OK.

Note

• Programming Code has to be entered when the System Administrator start KX-TVA 
Maintenance Console.

Default
None

Value Range
Max. 16 digits.
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2.8 System Security
Feature Manual References
2.4.8 System Security

Login Failure before Disconnection
Specifies the times of invalid password entry for the System Administrator to login the VPS. If the 
invalid password is entered over this parameter's setting, the VPS disconnects a call. This parameter 
is applied to login by the System Manager or the Message Manager from their telephone.

Default
3

Value Range
 1–99 times

System Manager Access from Telephone
Enables or disables access to the VPS from the System Manager's telephone.

Note

• The System Administrator will be asked to set the System Manager's password if both of the 
following conditions are met:

a) The System Administrator changes this parameter from "Disable" to "Enable".

b) The System Manager's password has not been set previously.

• The password must be entered 2 times for verification.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.4.8 System Security

Password for System Manager
If "Enable" is selected in "System Manager Access from Telephone", assign here a password for the 
System Manager to login the VPS. A combination of numbers can be used.

Follow the steps below to change the password:

1. Click Click to change password….

2. Enter a new password in Enter new password:.

3. Enter the new password in Confirm new password:.

4. Click OK.

Default
None
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2.8 System Security
Value Range
Max. 16 digits

Feature Manual References
2.4.8 System Security

Message Manager Access from Telephone
 Enables or disables access to the VPS from the Message Manager's telephone.

Note

• The System Administrator will be asked to set the Message Manager's password if both of 
the following conditions are met:

a) The System Administrator changes this parameter from "Disable" to "Enable".

b) The Message Manager's password has not been set previously.

• The password must be entered twice for verification.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.4.8 System Security

Password for Message Manager
If "Enable" is selected in "Message Manager Access from Telephone", assign here a password for the 
Message Manager to login the VPS. A combination of numbers can be used.

Follow the steps below to change the password:

1. Click Click to change password….

2. Enter a new password in Enter new password:.

3. Enter the new password in Confirm new password:.

4. Click OK.

Default
None

Value Range
Max. 16 digits

Feature Manual References
2.4.8 System Security
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2.8 System Security
2.8.2 Subscriber

Minimum Password Length
Specifies the minimum length (number of digits) of mailbox passwords.

Default
4

Value Range
0-16 digits

Enable Login Failure Disconnection
Specifies whether the VPS disconnects a call when the subscriber enters an invalid password n 
times. (n=the value specified under "Login Failures before Disconnection")

Default
Enable

Value Range
Disable, Enable

Login Failures before Disconnection
Specifies the number of times an invalid password can be entered before the VPS disconnects the 
call. In order to use this feature, "Enable Login Failure Disconnection" must be set to "Enable".

Default
3

Value Range
1–99 times

Default Password for New Mailboxes
Specifies whether the default password is assigned to new mailboxes automatically when they are 
created.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.4.8 System Security
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2.8 System Security
Default Password 
Specifies the default password assigned to new mailboxes when "Default Password for New 
Mailboxes" is set to "Enable". There are 2 types of default passwords: select either "Fix digit" or "Prefix 
+ Mailbox No.".

Fix digit (which length is minimum password length)
Specifies the fixed password, which digit is minimum length. A combination of numbers can be used.

Default
1111

Value Range
Max. 16 digits

Prefix (1 or 2 digits) + Mailbox No.
 Specifies the default password for new mailboxes as a combination of fixed digits (1 or 2 digits) and 
the mailbox number.

Default
55 + Mailbox No.

Value Range
1 digit: 0–9 + Mailbox No.

2 digits: 00–99 + Mailbox No.
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Glossary

Alternate Extension Group
The extensions assigned to an Alternate Extension Group receive transferred calls via the sequence 
specified as the group's "Alternate Extension Transfer Sequence".

APT Integration
Digital integration between the VPS and certain Panasonic PBXs. Requires upgraded software in the 
PBX. When the VPS and PBX use APT Integration, voices are sent using analog technology, and data 
is sent digitally. Depending on the model and/or the software version of the connected PBX, you may 
not be able to utilize certain features available only with APT Integration. For more information, 
consult your dealer.

Auto Configuration
Available with APT/DPT Integration only. Simplifies initial system setup by reading information from 
the PBX and automatically creating mailboxes in the VPS to correspond to the extensions connected 
to the PBX. Auto Configuration can be initiated with the appropriate Mode Switch setting or by System 
Administration (Quick Setup).

Auto Forwarding
Allows unplayed messages to be copied or moved to another mailbox.

Auto Receipt
Allows a subscriber or the System Manager to receive a message to confirm the reception of sent 
messages to other subscribers.

Automated Attendant
The Automated Attendant feature of the VPS requests the caller to enter an extension number and 
then the VPS dials the number. If there is no answer or the line is busy, the caller is given certain 
options, including the option to leave a message in a mailbox. This is the advantage of calling an 
extension indirectly through the Automated Attendant rather than calling it directly.

Automatic Log-in
Available with APT/DPT Integration only. Allows subscribers to access their mailboxes directly without 
entering their mailbox numbers. Subscribers can access their mailboxes directly from their extensions 
or from outside phones by dialing a preprogrammed telephone number (either a DID number or a 
telephone number that reaches the PBX via a preprogrammed Trunk [CO line]) or by calling the VPS 
from a preprogrammed telephone number (Caller ID number).
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Autoplay New Message
The VPS plays new messages automatically when a subscriber, the System Manager, or the 
Message Manager logs in to his or her mailbox.

Bookmark
Enables a subscriber, the System Manager, or the Message Manager to set a specific point 
(Bookmark) in a message and easily resume playback later from that point.

Call Blocking
Allows subscribers to have their calls handled by the Incomplete Call Handling Service without ringing 
at their extensions.

Call Screening
Allows subscribers to screen calls. The VPS prompts the caller with the message "Record your name 
at the tone", and records the caller's name. The caller is put on hold while the VPS calls the subscriber 
and plays back the caller's name. The subscriber can then decide whether to take the call or not.

Called Party ID
(Sometimes referred to as Follow-On ID) Allows the PBX to dial extra digits to bring the caller directly 
to a specified mailbox, rather than to the General Delivery Mailbox.

Caller ID Callback
Available with APT/DPT Integration only. Enables a subscriber to use the Caller ID number 
information included with a message to call back the message sender without dialing the caller's 
telephone number.

Caller ID Call Routing
Available with APT/DPT Integration only. The VPS automatically sends calls from preprogrammed 
Caller ID numbers to a specified extension, mailbox (including Mailbox Group) or Custom Service.

Caller Name Announcement (System/Personal) 
Available with APT/DPT Integration only. The VPS announces prerecorded Caller ID caller names 
when: 
(1) subscribers listen to messages received from preprogrammed telephone numbers left in their 
mailboxes. 
(2) the VPS transfers calls from preprogrammed telephone numbers to subscribers (Caller ID 
Screening). 
(3) the VPS pages subscribers by intercom (Intercom Paging).  
Caller names can be recorded and played for all subscribers (system) or can be recorded by 
individual subscribers and played for their own calls only (personal). If the same Caller ID number is 
programmed for both System and Personal Caller Name Announcements, the VPS will use the caller 
name recorded by the subscriber.
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Company Greeting
A maximum of 32 Company Greetings can be recorded to greet callers. One (or System Greeting or 
none) can be selected for each Day, Night, Lunch, Break, and Holiday service based on a port and 
trunk (CO line).

Company Name
This is played by the VPS to the intended receiver of an External Delivery Message when he or she 
is unable to enter correctly the password (if a password is required to listen to the message). This 
helps him or her to realize where the call came from and contact the message sender if necessary.

Covering Extension
Allows subscribers to set another extension as the destination for their calls. Callers can be directed 
to the covering extension either by the Incomplete Call Handling feature, or by pressing [0] while 
listening to a subscriber's personal greeting message or while leaving a message.

Custom Service Builder
Allows the System Administrator to create Custom Services visually, using KX-TVA Maintenance 
Console. Each Custom Service and its functions can be edited and arranged using a familiar drag-
and-drop interface.

Custom Service
Allows callers to perform specific functions by pressing dial buttons on their telephones while listening 
to voice guidance (Custom Service Menus). Custom Services allow callers to connect themselves to 
an extension, mailbox, Mailbox Group, operator, fax machine, etc., without the assistance of an 
operator. The System Administrator can create a maximum of 100 Custom Services.

Default Mailbox Template
Is used as a template when the System Administrator creates consecutive mailboxes. It enables the 
System Administrator to apply basic settings (Mailbox Parameters, Message Waiting Notification, 
External Message Delivery, Auto Forwarding) to multiple mailboxes simultaneously.

Default Setting
A parameter defined for the VPS at the factory which can be changed through system programming 
by the System Administrator or the System Manager.

Delayed Ringing
There are 2 kinds of delayed ringing applications.  
(1)The VPS is used as the no-answer destination for the Intercept Routing feature of your PBX.  
(2) DIL 1:N (trunk [CO line] to several extensions) terminates on telephones and VPS ports. To give 
the telephone users a chance to answer calls, the VPS lines should be programmed for delayed 
ringing. Otherwise, the VPS will answer the calls immediately.
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Delete Message Confirmation
The VPS requests confirmation from the subscriber before erasing a message left in his or her 
mailbox.

Delivery Time
The time specified by the subscriber for the VPS to deliver a prerecorded message. Subscribers can 
specify the delivery time when leaving messages for other subscribers or when sending a message 
via External Message Delivery.

DID Call Routing
Available with DPT Integration only. The VPS automatically sends calls from preprogrammed DID 
numbers to a specified extension, mailbox (including Mailbox Group) or Custom Service.

DPT Integration
Digital integration between the VPS and certain Panasonic PBXs. Requires upgraded software in the 
PBX. When the VPS and PBX use DPT Integration, voices and data are sent digitally. Depending on 
the model and/or the software version of the connected PBX, you may not be able to utilize certain 
features available only with DPT Integration. For more information, consult your dealer.

DTMF
Dual Tone Multi Frequency. Commonly referred to as touchtone.

E-mail Integration
Allows subscribers and the Message Manager to receive notification by e-mail when they receive new 
messages. Subscribers can also have the voice message attached to the e-mail notification if the 
System Administrator has enabled this feature for their mailboxes.

External Delivery Message
A message recorded by a subscriber and then delivered to outside parties and/or extensions. The 
VPS dials the outside telephone number or extension number and plays the message for the 
recipient. The message can be delivered immediately or at a specified time.

External Message Delivery List
A preprogrammed list of outside parties and extensions that can be used to deliver an External 
Delivery Message to several recipients in one operation. Each subscriber can create 2 External 
Message Delivery Lists. Each list can have 8 destinations.

External Message Delivery Retry
Determines how many times the VPS will attempt to deliver an External Delivery Message when the 
called line (recipient) is busy or does not answer.

Fast Forward
Allows a subscriber to fast forward through a message in 4 second intervals. 
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Follow-On ID
(see "Called Party ID")

General Delivery Mailbox
A special mailbox that is maintained by the Message Manager. If a caller does not have a DTMF-
compatible telephone, the caller cannot dial numbers in order to connect himself or herself to an 
extension or mailbox. Callers who do not dial any numbers can be directed to the General Delivery 
Mailbox.  
Periodically (daily is best), the Message Manager should transfer messages in the General Delivery 
Mailbox to the appropriate subscriber mailboxes.

Hash Sign
The [#] key on the telephone keypad. Also known as the "pound sign".

Immediate Reply
Allows the message recipient to reply to a message without specifying the extension number or the 
mailbox number of the sender.

Inband Integration
When the VPS and PBX use Inband Integration, voices are sent using analog technology, and data 
is sent using analog DTMF tones. The PBX informs the VPS of the status of extensions by sending 
DTMF tones and Call Progress tones to the VPS. Many features, such as Intercom Paging, Live Call 
Screening (LCS), etc., are not available with Inband Integration.

Incomplete Call Handling Service
Calls are considered incomplete when is the called extension does not answer, is busy, or has set 
Call Blocking. 
Incomplete Call Handling can handle calls in 7 different ways. Each subscriber can specify the options 
available to callers when their calls are incomplete. 
(1) leave a message in the subscriber's mailbox 
(2) transfer to the subscriber's Covering Extension 
(3) Intercom Paging (notify the subscriber by paging the subscriber) 
(4) Beeper Access (notify the subscriber by paging the subscribers beeper) 
(5) transfer to Custom Service 
(6) transfer to operator 
(7) return the caller to the top menu, allowing the caller to call another extension

Intercept Routing—No Answer
A PBX feature that transfers an unanswered call to another extension or to the VPS.
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Intercom Paging
Available with APT/DPT Integration only. If a subscriber has set Intercom Paging, the VPS will page 
the subscriber and announce that he or she is receiving a call. The VPS can announce prerecorded 
caller names using the Caller Name Announcement feature, or prompt the caller to record his or her 
name and announce the recorded name. Pages can be heard through PT speakers or through 
external speakers connected to the PBX.

Interview Service
Allows the VPS to "interview" a caller by playing a series of prerecorded questions and recording the 
caller's responses. Subscribers are able to record questions directly into their interview mailboxes. 
After a caller records his or her answers, the Message Waiting Lamp turns on at the subscriber's 
telephone. This feature is very useful for claims departments, order desks, job applications, etc.

Keypad
The dial keys ([0]–[9], [ ], [#]) on a telephone.

LCD
Liquid crystal display

Live Call Screening (LCS)
Available with APT/DPT Integration only. Allows the subscriber to use his or her PT to monitor 
incoming calls as messages are being recorded. The subscriber has the option of answering calls 
while monitoring or allowing the message to be recorded without interruption.

Logical Extension (All Calls Transfer to Mailbox)
An extension that always receives calls directly into its mailbox. This feature is used by subscribers 
who are often unavailable or who do not have a telephone. 

Mailbox Capacity (recording time)
The total length of time for all messages that can be recorded in a subscriber's mailbox. The System 
Administrator or System Manager can set each subscriber's maximum mailbox capacity. Each 
subscriber's mailbox capacity is determined by COS. 

Mailbox Capacity Warning
Allows the VPS to alert subscribers when recording time for their mailboxes are running low. The 
warning announcement will be heard at the beginning of Subscriber's Service. 

Mailbox Group
A preprogrammed list of subscriber mailboxes that can be used (by any subscriber) to deliver a 
message to several recipients in one operation. Up to 20 Mailbox Groups can be created. 
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Mailbox Number
Normally the same number as the corresponding subscriber's extension number.

Message Envelope Setting
Specifies when message envelopes (message date and time, name of the person who recorded or 
transferred the message, telephone number of the caller) are announced. Envelopes can be played 
back before or after messages automatically, or only when the subscriber presses [2] [3] during or 
after message playback.

Message Manager
Mailbox 998. The person who takes care of message-related maintenance, such as General Delivery 
Mailbox maintenance, and recording and deleting messages (System Prompts, Company Greetings, 
Custom Service Menus, System Caller Names, etc.)

Message Recovery
Allows a subscriber to change the status of a message from "deleted" to "old", preventing the 
message from being permanently deleted. 

Message Retention Time
Determines the number of days before a message is automatically deleted. 
New Message Retention Time: Determines when new (unplayed) messages are deleted.  
Saved Message Retention Time: Determines when old (played) messages are deleted.

Message Retrieval Order
When a subscriber has several messages in his or her mailbox, determines whether messages are 
played back from newest to oldest (Last In First Out [LIFO] or from oldest to newest First In First Out 
[FIFO]).

Message Transfer
Allows a subscriber to reroute a message to another mailbox and add his or her comments to the 
message if necessary. Receipt messages and messages originally marked as "private" cannot be 
transferred.

Message Waiting Lamp
The lamp on a PT that lights when there are messages in the extension user's mailbox.

Message Waiting Notification
Notifies subscribers and the Message Manager when they have received messages, by lighting the 
Message Waiting Lamp on their PTs, by calling a preprogrammed telephone number, or by paging a 
beeper.
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Multilingual Selection Menu
Allows callers to select the language they would like to hear for voice guidance (system prompts). 3 
languages can be selected for the Multilingual Selection Menu of the KX-TVA50; 5 languages for the 
KX-TVA200.

Non-Subscriber
A caller to the VPS who does not own a mailbox.

Notification Method
(see "Message Waiting Notification") 

On Hold Announcement Menu
Allows callers in a queue to listen to the prerecorded announcement or music while they are on hold.

One-touch Two-way Transfer (One-touch TWT)
Available with KX-TDA series and KX-TAW series PBXs using DPT Integration only. Allows a 
subscriber to record his or her telephone conversations into another subscriber's mailbox with a one-
touch operation.

Operator
3 different extensions can be assigned as operators for each time mode. Callers can be directed to 
an operator when they dial [0], when they have rotary or pulse telephones (and thus cannot dial while 
listening to VPS prompts), or when certain VPS features are programmed to direct callers to an 
operator. 

Owner's Name
Each mailbox has an owner's name (subscriber name), and there are 2 ways that these names are 
stored in the VPS.  
First, subscribers can record their own names; the VPS can announces this recorded name during 
transfers, Intercom Paging, and when callers use the Dialing by Name feature.  
Second, the System Administrator can assign a text name for each subscriber. This allows callers to 
dial subscribers extension's by name (Dialing by Name) rather than by number. For example, a caller 
can dial "S-M-I-T" (Smith) rather than Smith's mailbox number, which can be hard to remember. 

Password
A combination of numbers that protects a subscriber's mailbox from unauthorized access. If forgotten, 
the System Administrator or the System Manager can clear it so that the subscriber can select a new 
password. 
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Personal Custom Service
Similar to a Custom Service, allows callers to perform specific functions by pressing dial buttons on 
their telephones while listening to the subscriber's Personal Greeting Message. A subscriber's 
Personal Custom Service can allow callers to connect themselves to another extension, mailbox, 
outside telephone (such as the subscriber's mobile phone), etc., without the assistance of an 
operator. Each subscriber can create his or her own Personal Custom Service.

Personal Greetings
Subscribers can record 3 greeting messages that greet callers who are directed to their mailboxes. 
The Personal Greeting heard by callers depends on the status of the subscriber or VPS.  
No Answer Greeting: Heard by callers when the subscriber does not answer.  
Busy Signal Greeting: Heard by callers when the subscriber is busy.  
After Hours Greeting: Heard by callers when the VPS is in night mode.

Personal Greeting for Caller ID
Available with APT/DPT Integration only. A subscriber can record a maximum of 4 Personal Greeting 
messages that are played for callers whose telephone numbers (Caller ID numbers) have been 
assigned to a Personal Greeting for Caller ID. A maximum of 8 Caller ID numbers can be assigned to 
each greeting.

Personal Group Distribution List
A preprogrammed list of subscriber mailboxes that can be used (by the subscriber who created the 
list) to deliver a message to several recipients in one operation. Each subscriber can create 4 
Personal Group Distribution Lists. Each list can have 40 members.

Personal Programming
Also known as Station Programming. PBX programming that is performed by an extension user to 
customize his or her extension's settings. In order to user certain VPS features, such as Live Call 
Screening (LCS), personal programming may be required.

PIN Call Routing
Allows preferred callers to be directed to a specific extension, mailbox, or Custom Service when they 
enter their assigned PIN.

Playback Volume/Speed Control
Allows subscribers to control playback volume and speed while listening to messages.

Port
The point of connection between the PBX and the VPS.

Pound Sign
The [#] key on the telephone keypad. Also known as the "hash sign".
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Private Message
A message designated by the sender as private. Private messages cannot be forwarded by the 
recipient. 

Remote Call Forwarding Set
Available with DPT Integration only. Allows subscribers and the Message Manager to program their 
extensions from a remote location to forward various types of calls (all calls, no answer, busy, etc.) to 
a desired extension, or to an outside telephone (Remote Call Forward to CO).

Remote Call Forward to CO
Available with DPT Integration only. Allows subscribers and the Message Manager to program their 
extensions from a remote location to forward their calls to an outside telephone, if authorized.

Rewind
Allows a subscriber to replay the last 4 seconds of a message.

Rotary Telephone
A telephone that is not capable of emitting DTMF (touchtone) signals. Callers using rotary telephones 
will be automatically forwarded to an operator or the General Delivery Mailbox because they cannot 
dial numbers as directed by the VPS prompts.

Service Group
A group of settings which determine how incoming calls are handled by the VPS. One of 8 call service 
groups is assigned to each VPS port or PBX trunk (CO line).

Service Mode
Determines if incoming calls are handled by the VPS according to settings made for day mode, night 
mode, lunch mode, or break mode. The current mode can be changed automatically (either by the 
VPS or by the time mode settings of the PBX) or can be changed manually by the System 
Administrator and System Manager. Each Service Group is assigned a Service Mode.

Subscriber
A person who has an assigned mailbox.

Subscriber Tutorial
Guides subscribers through the mailbox configuration process the first time they access their 
mailboxes. The subscriber's password, owner's name, and No Answer Geeting can be configured 
using the Subscriber Tutorial.
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System Administration
Includes system programming, diagnosis, system prompt administration, etc. They are performed by 
the System Administrator, using a PC running the KX-TVA Maintenance Console software. System 
Administration can be performed locally (on-site) by connecting to the VPS via USB or LAN, or 
remotely (off-site) by connecting to the VPS via the optional modem card.

System Administrator
Is the person responsible for programming the most essential VPS settings. Unlike the Message 
Manager and the System Manager, who use a telephone to perform their duties, the System 
Administrator uses a PC running the KX-TVA Maintenance Console software to program the VPS. 
The System Administrator's handbook is the Programming Manual. Only one programming session 
is possible at a time.

System External Message Delivery Duration Time
Specifies the maximum telephone connection time allowed for External Message Delivery. Prevents 
excessive telephone charges.

System Manager
Mailbox 999. The person who can perform a subset of the items that can be programmed by the 
System Administrator. The System Manager, using a telephone connected to the VPS, can create/
delete mailboxes, clear subscriber passwords when they are forgotten, set Class of Service 
parameters, set the System Clock, etc.

System Prompt
Recorded voice guidance messages that help subscribers and callers use VPS features. Over 1000 
prompts are prerecorded in the VPS.  
The System Administrator and Message Manager can rerecord prompts as necessary. 
The System Administrator and the Message Manager can turn system prompts on and off as needed. 
Each system prompt has a unique number.

System Report
The System Administrator or the System Manager can generate various System Reports to monitor 
the status of the VPS.

System Security
By default, the System Manager and Message Manager cannot access the VPS from their 
telephones until the System Administrator sets their passwords and allows them to access the VPS 
via their telephones. The System Manager and Message Manager must always enter their passwords 
in order to access the VPS. 
The System Administrator can also choose to set a default password for subscriber's mailboxes. If 
this setting is enabled, a default password is automatically assigned when mailboxes are created.
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Temporary Personal Greeting
A special greeting that, if recorded by a subscriber, is heard by callers instead of the subscribers other 
Personal Greetings. Often used to inform callers of a temporary absence. A common example might 
be, "This is (name). I'm out of the office this week…".

Time Synchronization
Available with DPT Integration only. When the date and time is set for the PBX or when DPT 
Integration is established, date and time data is sent from the PBX to the VPS.

Timed Reminder Setting
Available with DPT Integration only. Allows a subscriber to set a Timed Reminder by following system 
prompts provided by the VPS. Timed Reminder is a PBX feature that is similar to an alarm clock; the 
telephone will ring at the set time (once or daily) as set by the subscriber or Message Manager.

Toll Saver
Allows a subscriber to check his or her mailbox for new messages by calling the VPS from a 
preprogrammed Caller ID number, by dialing a preprogrammed DID number, or by dialing a telephone 
number that connects the call to a preprogrammed trunk (CO line) of the PBX. Toll Saver is a cost-
saving feature that lets the subscriber know if he or she has new messages by the number of rings 
heard before the VPS answers the outside call from the subscriber. If the VPS does not answer the 
call within a preprogrammed time period, the subscriber can disconnect the call and thus avoid 
telephone charges.

Two-way Record
Available with APT/DPT Integration only. Allows a subscriber to record his or her telephone 
conversations into his or her mailbox.

Two-way Transfer
Available with APT/DPT Integration only. Allows a subscriber to record his or her telephone 
conversations into another subscriber's mailbox. The subscriber must specify the desired extension 
number when using this feature.

Unlimited Message Length
Allows a subscriber to record telephone conversations of an unlimited length of time when using Two-
way Record and Two-way Transfer. The maximum recording time for other messages will be 
automatically set to 60 minutes.

Urgent Message
A message designated by the sender as urgent. Urgent messages are played back before other 
messages when the recipient listen to his or her messages.
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VM Menu
Available with KX-TDA series PBXs using DPT Integration only. Displays VPS text prompts on the 
display of a compatible PT, allowing the subscriber to operate the VPS by following text prompts and 
pressing soft buttons and the Navigator Key. Voice prompts are not used.

Voice Mail
A general term used for messages recorded by the VPS and stored in subscriber mailboxes.

VPS
A Voice Processing System, such as the Panasonic KX-TVA50, and KX-TVA200.
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